
Shopware Extensions
You can use extensions to expand the standard range of Shopware functions. The extensions are managed
via the extensions manager.

Further information, e.g. on the installation of extensions, can be found here.

The extended functions (features) of Shopware Rise, Shopware Evolve and Shopware Beyond are made
available to you within the Shopware Commercial extension. If you have purchased a corresponding plan
and activated the extension, the available features will be unlocked and available. However, some features
require the installation of the separate extension and are not automatically provided via Shopware
Commercial. The following table should give you an overview of this.

Overview of features extensions per plan

In the following table you will find an overview of which features are available in your plan.

Features / Plans Shopware Rise Shopware Evolve Shopware Beyond

Content Management & Design

Premium Themes X X X

CMS Rules X X

Quick view X X
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Scroll-Navigation
 (Storytelling) X X

Immersive Elements X X X

Workflow & Automation

Publisher   X X

Customer experience & Marketing

Social Shopping X X X

Dynamic Access X X

Form Builder X X

Digital Sales Rooms X
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Inventory & Order management

Custom Products X X X

The most up-to-date overview of all available features per plan can be found in the comparison on the
prices page of the Shopware homepage.

Advanced Search
The Advanced Search is available to you as an extension of the Shopware Evolve plan.

The Advanced Search gives you easy configuration options and high performance due to the Elasticsearch
foundation.

Advanced Search can be used as a separate extension up to Shopware 6.4.20.2; the plugin can no longer
be installed in version 6.5. The successor Advanced Search 2.0 is available from Shopware 6.5.7.0 and
requires OpenSearch as the search engine. The functionality is automatically available in the admin, if the
Commercial plugin was installed and activated. You can find out more about the successor to this
extension here.

Requirements

Since Advanced Search is based on Elasticsearch, an Elasticsearch instance is a basic requirement for
operation. How to integrate Elasticsearch into Shopware 6 is explained here.

Installation

As part of the Shopware Evolve plan, Advanced Search is available to you as an extension.
You can download and install the extension under Extension > My Extensions.
If you have logged in to the Shopware Account tab, the extension will be listed in the General tab and can
be installed via the "..." button.
After the extension is installed, you can activate it using the button to the left of the extension.

You can find more information about extension management here.
 

https://docs.shopware.com/en/shopware-6-en/extensions/customproducts
https://www.shopware.com/en/pricing/
https://docs.shopware.com/en/shopware-6-en/settings/advanced-search-2-0
https://developer.shopware.com/docs/concepts/framework/elasticsearch.html
https://docs.shopware.com/en/shopware-6-en/settings/plugins#install-plug-ins


Could not install plugin

Should you receive the following message during the installation of the extension

"Could not install plugin, got 1 failure(s). Required plugin/package "shopware/platform >=v6.0

it is necessary to adjust the composer.json of the extension.
You can find the extension in the Shopware directory under
/custom/plugins/SwagEnterpriseSearchPlatform.
In the composer.json you have to adjust the following code

"require": {
"shopware/platform": ">=6.1.0 < 6.3.0"
},

Replace the entry

"shopware/platform": ">=6.1.0 < 6.3.0"

with

"shopware/core": ">=6.1.0 < 6.3.0",
"shopware/storefront": ">=6.1.0 < 6.3.0",
"shopware/administration": ">=6.1.0 < 6.3.0",
"shopware/elasticsearch": ">=6.1.0 < 6.3.0"

After you have saved the changes, you can install the extension in the admin under Extensions > My
Extensions.

Configuration

You can find the configuration of the Advanced Search under Settings > Extensions > Shopware
Advanced Search.

Overview

In the tab overview you can configure the basic configuration of the search.



In the General Settings section, Which information is indexed or even boosted (1) calls up a modal
in which you specify the records to be considered for the search.

In the hit count section you define the number of elements displayed in the quicksearch (2) and on the
search results page (3).

Searchable information



To specify the data to be searched, first select the entity (1) for which you want to make the setting. In
the Advanced Search, products, categories and manufacturers can be searched.

Afterwards a list with all available records for the selected entity will be displayed below. There you can
determine whether each record should not be searched (2), searched (3) or prioritized (4).
Prioritized means that hits are given twice the weighting for the content of this record.

For records that are defined as text (e.g. varchar) at database level, you can also specify whether partial
hits (5) should also be included and whether compound words (6) should also be included.
Partial hits are smaller word parts of a longer term (e.g. keyboard)
For compound words, several words are combined even without entering a space (key board also finds
keyboard)

After you have initially configured the indexing settings, it is necessary to perform indexing from the server
console. For information on how to perform indexing, see the section Indexing.

Please note that the configuration of the indexed data is currently not possible for specific sales channels.

The most important variables are explained below:

Field Description



fullText Standard Shopware field with low priority

fullTextBoosted Standard Shopware field with higher priority

price.gross Gross price

price.net Net price

productNumber Product number

stock Stock

restockTime Replenishment time in days

autoIncrement Graduation

availableStock Available stock

variation Product variant



displayGroup String field with IDs to display the content

manufacturerNumber Manufacturer number

ean EAN number

purchaseSteps Quantity steps of purchase

maxPurchase Maximum purchase

minPurchase Minimum purchase

purchaseUnit Sales unit

referenceUnit Basic unit

purchasePrices.gross Gross purchase price

purchasePrices.net Net purchase price



weight Weight

width Width

height Height

length Length

ratingAverage Valuation on average

categoryTree Category tree

propertyIds Properties IDs

optionIds IDs of the options

tagIds Tag IDs

categoryIds Category IDs



childCount Number of variants

sales Sales

metaDescription Meta product description

name Product name

keywords Search keywords

description Product description

metaTitle Meta title

packUnit Packaging unit

packUnitPlural Packaging unit-multiple

customSearchKeywords Search keywords defined in admin



deliveryTime.unit Delivery time unit

deliveryTime.max Maximum delivery time

deliveryTime.min Minimum delivery time

deliveryTime.name Name of delivery time

tax.position Position of the tax

tax.name Tax name

tax.taxRate Tax percentage

manufacturer.description Manufacturer description

manufacturer.name Manufacturer name

manufacturer.link Link of the manufacturer



unit.name Unit of measurement name

unit.shortCode Unit of measurement short form

cover.position Position of the preview image in the media overview of
the item.

cmsPage.entity Element

cmsPage.type Layout type of the deposited experience world

cmsPage.name Name of the deposited experience world

canonicalProduct.customSearchKeywords SEO data of the respective value

canonicalProduct.packUnitPlural SEO data of the respective value

canonicalProduct.packUnit SEO data of the respective value



canonicalProduct.metaTitle SEO data of the respective value

canonicalProduct.description SEO data of the respective value

canonicalProduct.keywords SEO data of the respective value

canonicalProduct.name SEO data of the respective value

canonicalProduct.metaDescription SEO data of the respective value

canonicalProduct.sales SEO data of the respective value

canonicalProduct.childCount SEO data of the respective value

canonicalProduct.categoryIds SEO data of the respective value

canonicalProduct.tagIds SEO data of the respective value

canonicalProduct.streamIds SEO data of the respective value



canonicalProduct.optionIds SEO data of the respective value

canonicalProduct.propertyIds SEO data of the respective value

canonicalProduct.categoryTree SEO data of the respective value

canonicalProduct.ratingAverage SEO data of the respective value

canonicalProduct.length SEO data of the respective value

canonicalProduct.height SEO data of the respective value

canonicalProduct.width SEO data of the respective value

canonicalProduct.weight SEO data of the respective value

canonicalProduct.purchasePrices.gross SEO data of the respective value

canonicalProduct.purchasePrices.net SEO data of the respective value



canonicalProduct.referenceUnit SEO data of the respective value

canonicalProduct.purchaseUnit SEO data of the respective value

canonicalProduct.minPurchase SEO data of the respective value

canonicalProduct.maxPurchase SEO data of the respective value

canonicalProduct.purchaseSteps SEO data of the respective value

canonicalProduct.ean SEO data of the respective value

canonicalProduct.manufacturerNumber SEO data of the respective value

canonicalProduct.displayGroup SEO data of the respective value

canonicalProduct.variation SEO data of the respective value

canonicalProduct.availableStock SEO data of the respective value



canonicalProduct.autoIncrement SEO data of the respective value

canonicalProduct.restockTime SEO data of the respective value

canonicalProduct.stock SEO data of the respective value

canonicalProduct.productNumber SEO data of the respective value

canonicalProduct.price.gross SEO data of the respective value

canonicalProduct.price.net SEO data of the respective value

prices.quantityEnd Maximum quantity of the product that must be in the
shopping cart for this price to be valid.

prices.quantityStart Minimum quantity of the product that must be in the
shopping cart for this price to apply.

crossSellings.limit Maximum number of products



crossSellings.type Cross selling type

crossSellings.sortDirection Cross selling order Direction

crossSellings.sortBy Cross selling order

crossSellings.position Cross selling position

crossSellings.name Cross selling name

visibilities.visibility Visibility

searchKeywords.ranking Search Keyword

searchKeywords.keyword Search Ranking

productReviews.comment Product review comment

productReviews.points Product review rating



productReviews.content Product rating content

productReviews.title Product review title

productReviews.externalEmail Mail of the end customer

productReviews.externalUser First name of the end customer

seoUrls.url SEO URL

orderLineItems.type Type of ordered position

orderLineItems.totalPrice Total price of the ordered item

orderLineItems.unitPrice Unit price of the ordered position

orderLineItems.quantity Quantity of the ordered position

orderLineItems.price Price field



orderLineItems.discount Discount of the ordered item

orderLineItems.percentage Discount percentage

orderLineItems.label Name of the ordered item

orderLineItems.referencedId Product ID of the ordered item

orderLineItems.identifier Product ID of the ordered item

options.colorHexCode Color code of the color stored in the property.

options.name Name of the variant

properties.colorHexCode Color hex code of the property

properties.position Position of the property

properties.name Name of the property



categories.keywords Category Keywords

categories.metaDescription Category Meta Description

categories.metaTitle Category Meta Title

categories.description Category Description

categories.externalLink Category External Link

categories.linkType Category Link Type

categories.name Category Name

categories.productAssignmentType Product Assignment Type

categories.type Category type

categories.childCount Number of subcategories



categories.path Category path

categories.level Category level

categories.autoIncrement Unique decimal number

Preview

The preview allows you to test the search settings directly in Admin.

To use the preview, first select the sales channel (1) for which you want to test the search.
With the selection (2) next to the search field (3) you can determine whether you want to test the
search for products, categories or manufacturers.
In this list you a ranking for the search results will also be shown, so that you can see the relevance of the
search term. This ranking is calculated by means of the Elasticsearch search algorithms. You can get some
more information about the ranking of a search result by hovering the mouse over the ranking of the
search result..

Boostings

In addition to the prioritization of individual records to be searched, it is possible to create additional
boosts. A boosting offers you specific configuration options, e.g. to display certain products further up in
the search results.

Product boosting

Existing dynamic product groups are used for the boosting of products. The products that are available in
the product group and to which the search query generally applies are given a higher rating.

https://docs.shopware.com/en/shopware-6-de/Catalogues/Dynamicproductgroups


If you have not yet created a corresponding dynamic product group, we recommend that you do so as a
first step.

To configure a product boost, first enter a Name (1) and the desired boosting relevance in the field Boost
(2). This boosting relevance is added to the products' already received relevance. To activate the boosting,
click on the Active button (3).
Optionally it is possible to use the boosting only in a certain period of time. To do this, set the period in the
fields Active from (4) and Active to (5).
As stream type (5) select Product Stream, this will display the field TypeId (7). In the TypeId selection
field you can then choose from the existing dynamic product groups..

Category and manufacturer boosting

You can define your own rules for the boosting of categories and manufacturers directly in the boosting
modal.



When configuring a category or manufacturer boost, first assign a name (1) and the desired boosting
relevance in the field Boost (2). To activate this boosting, click on the Active button (3).
With the fields Active from (4) and Active to (5) you can limit the boosting in time without having to
switch it on or off manually at a certain time.
As stream type (6) select Entity Stream, in the field Type (7) category or manufacturer.
Afterwards the possibility to create rules (8) is shown. This rule configuration is based on the Rule Builder
. With this you can create individual conditions on the basis of which the boosting is to be applied.

Actions

With actions, it is possible to search for a specific phrases/keywords in the name. The customer will be
forwarded automatically to a definied area (Url, product or categorie)

Add action

Name (1): Enter a name for the action.
Search terms (2): Here you can enter the search terms or keywords.
Active (3): Define in which period the promotion is valid.

https://docs.shopware.com/en/shopware-6-en/settings/rules


Type (4): Here you can choose whether the customer should be redirected to a defined URL, product or
category when the search term is searched.
URL / Product / Category (5): As mentioned in (4), you can define a URL, a product or a category,
depending on the type you choose.

Synonyms

In search, the term "synonyms" usually refers to the function where search engines or search tools display
alternative words or phrases that have a similar meaning to the search term entered. This feature helps
users refine their search results by offering them similar terms or variations that might be relevant.

For example, if someone searches for "car," a search engine could potentially display synonyms such as
"vehicle" or "motor vehicle" to give the user more options. This makes finding relevant information more
accessible and expands the search results' scope.

Left (1): Enter the synonym term for Equivalent or Defining synonyms here.
Language (2): Enter the language for the synonym.
Right (3): Enter a synonym term here that applies to Equivalent synonyms.

Indexing

After you have configured the Advanced Search for the first time, it is necessary to build the index. This is
done in 3 steps in the server console..

First the indices are created or updated

php bin/console es:index



After this step has been completed, the second step is the processing via the message queue. In most
systems this is done automatically by the Admin or CLI Worker. If you are unsure whether the message
queue is processed automatically, please have a look at our documentation article about the Message
Queue.

Finally you can create the aliases for the indexes. It should be said that this is usually done automatically.
In some systems this can be however necessary. If the indexes have been created successfully, but you
still do not see any products in your storefront, you can execute the following command.

php bin/console es:create:alias

The indexing works exactly the same way as with the technically underlying Elasticsearch integration.
Therefore you can find more information in the documentation of Elasticsearch.

So that now finally also new products and/or changes at existing products are taken over into the indices, it
is necessary to set SHOPWARE_ES_INDEXING_ENABLED=1 in the .env file in your store directory to 1
(active). If you change the configuration or the search settings, it is necessary to rebuild the search index.

Custom Popups & Notifications
With this extension, you have the possibility to inform your customers about promotions or to share
information quickly and easily.

Installation

Custom Popups & Notifications can be downloaded for free from the Store and then installed and
configured in the Administration (Extensions > My Extensions).

General configuration

Under Extensions > My Extensions > Custom Popups & Notifications you can access the general
configuration of the extension.
 

Consent Popup

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/message-queue-and-scheduled-tasks
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The consent popup opens a popup directly when visiting your store, which must be actively confirmed by
the customer.

Sales channel: First define for which sales channel you want to store the settings.
Show consent modal: Here you activate the approval dialog, which is displayed directly when you open
your store.
Title: Enter the desired title for your approval popup.
Description: Here you can enter the description, which the customer can read later.
Button label: Enter the text that should be displayed on the confirmation button.

In our configured example, your customers will receive the following dialog when they open your store:

Banner

The banner is displayed to your customers in the upper area of your store and allows you to spread
targeted information.



Show banner: Here you can activate the banner that will later be displayed in the upper area of your
store.
Banner is closable: Decide whether your banner can be closed or whether the information is always
displayed.
Background color: Adjust the background color of the banner to your store.
Font color: Adjust the font color of the banner to your store.
Display as marquee: In addition to a fixed text, your banner can also be displayed as a ticker, which then
moves into the customer's view in the upper area of your store.
Text: Enter your desired text here.

The configured banner will now be displayed in the upper area of your store:

Info Popup

The info popup is displayed to your customers directly when they open the store and can share news, for
example.



Show info popup: Here you activate the info popup that will later be displayed to your customers directly
when they call up the store.
Blur popup background: Configure in which way the background of the popup should be displayed.
Popup title: Define the title of your popup.
Popup text: Define here what exactly you want to tell your customers.
Popup image: You want to include your logo next to the headline and the text? Here you can select it.

Our info popup will appear in the store from now on:

Newsletter registration popup

With the newsletter registration popup you can actively refer your customers to your newsletter directly
when they visit your store and even let them register via the popup. 



Show newsletter registration popup: Enable your newsletter registration popup to point your
customers to your newsletter.
Show name input field: Determines whether to show first and last name input fields.
Headline: Give your popup a heading.
Text: What is your popup about? Enter it here.
Submit button text: At this point, give a text that will be inside the button.

Our result will look like this:

B2B-Suite - Administration
The B2B suite is available to you as an extension from the Shopware Evolve plan.

Please note that the B2B suite is no longer being developed. All new features will be handled via the B2B
components. 

The B2B Suite provides you with the option of equipping your store with the most important B2B functions.

https://docs.shopware.com/en/shopware-6-en/commercial-features/b2b-components
https://docs.shopware.com/en/shopware-6-en/commercial-features/b2b-components


These include budgets and quotas, order lists and quick orders.

Installation

As part of the Shopware Evolve plan, the B2B Suite is available as an extension.
You can download and install the extension under Extension > My Extensions.
If you have logged in to the Shopware Account tab, the extension will be listed in the General tab and can
be installed via the "..." button.
After the extension is installed, you can activate it using the button to the left of the extension.

You can find more information about extensions here.

Configuration

The B2B Suite does not provide a separate configuration menu in the Admin. Instead, the customer
administration is extended by configuration options (1).

In order to assign a B2B role to the customer, first open the edit mode (2).

Then you can assign one of the two roles (1) or (2) to the account by using the checkboxes.
Please note that a customer can only be assigned to one of the two roles.
If the customer is assigned to the customer role, you can also activate the Easy Mode (3). A customer
with activated Easy-Mode has a simplified view with fewer options available in his customer account.
Firstly, there is no role administration available in the easy mode. Furthermore, in this mode the customer
has no options to create and manage budgets or quotas. 

https://docs.shopware.com/en/shopware-6-en/settings/plugins#install-plug-ins


Exactly which functions are available for a debtor or sales representative account is explained in the next
section B2B Roles.

B2B Roles
Debtor

A debtor is the central administration account for a store customer to map his company organization. For
this purpose, various employee accounts as well as individual budgets and quotas can be created.
You will find the exact configuration options in the article B2B-Suite - Customer account

Sales representative

Sales representatives are accounts for employees of the store operator to whom debtor accounts can be
assigned in order to give employees direct access to the customers' store accounts.

Admin view
An account marked as a field sales representative gets an additional tab in the customer
configuration, where the assignment of the debtor accounts is done. It is necessary to enter the edit
mode to be able to make the assignment.
 

<

Storefront view
A sales representative will see an overview of the assigned customers in the storefront instead of the
normal account.
 

Using the person icon (1), the sales representative can log into the customer's account. This allows
the sales representative to use the same functions as the customer. Orders that are placed by the
sales representative through the customer account are marked accordingly.

https://docs.shopware.com/en/shopware-6-en/enterprise-extensions/b2b-suite-customer-account


In the My Account area (2) the sales representative can change his personal details and password.

B2B-Suite - Customer account
The B2B suite is available to you as an extension from the Shopware Evolve plan.

Please note that the B2B suite is no longer being developed. All new features will be handled via the B2B
components. 

The B2B suite offers a variety of functions for store customers who have been authorized by the store
operator to map their own company structure. These include roles and contacts (sub-accounts for customer
employees), budgets and quotas including the clearances process as well as order lists and own order
numbers.

This documentation describes the functions that the B2B suite provides for store customers and is
therefore written from the store customer's perspective.

In order to use these functions it is necessary that the store operator has set up a central customer account
for your company or has authorized it accordingly.
If you now log in to the store with this account, you can carry out the further configuration. For easier
administration the functions are divided into different areas.

B2B-Dashboard (1): The dashboard is the central overview of the B2B functions.
Company (2): In the Company section, the roles and contacts including authorizations, addresses,
budgets and quotas are managed.
Statistics (3): In the statistics you will find filterable evaluations of the orders placed.
Orders (4): Here you find overviews of the placed orders as well as the still open orders waiting
for clearance.

https://docs.shopware.com/en/shopware-6-en/commercial-features/b2b-components
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Order lists (5): Order lists allow easy planning of future or regular orders.
Fast order (6): With the fast order function you can add many products to your shopping cart with a
few clicks.
Offers (7): Contains an overview of the requested offers and offers the possibility to edit them.
Order numbers (8): Enable you to create and manage your own order numbers for the store's
products.
My Account (9): Provides an overview of personal data and allows you to change your own
password.

If you can't see certain areas, please check if the account you are logged in with has the necessary
permissions. If necessary, ask persons who have access to the debtor account of your company.

B2B-Dashboard

The overview in the dashboard shows all functions that are available to the logged-in user.
The customer has full access to all functions. The available functions for the other contacts (sub-accounts
of a debtor) depend on the assigned rights.

My profile

Debtors and contacts (sub-accounts of a debtor) can manage contact information such as salutation, first
name, last name, and email address themselves and edit it directly on the storefront.

You can customize contact information directly in the storefront using the My profile menu item (1).

https://docs.shopware.com/en/shopware-6-en/enterprise-extensions/b2b-suite-customer-account#order-lists
https://docs.shopware.com/en/shopware-6-en/enterprise-extensions/b2b-suite-customer-account#fast-orders
https://docs.shopware.com/en/shopware-6-en/enterprise-extensions/b2b-suite-customer-account#Offers
https://docs.shopware.com/en/shopware-6-en/enterprise-extensions/b2b-suite-customer-account#order-numbers


In the My Account section you will find your master data. In the Your Profile section (1), you can change
your title, first name and last name. Under E-mail address (2) you can change the e-mail address. Under
Change password (3) you can change the password.

Company

Here, the debtor or an appropriately authorized contact can carry out the administration of their own
company organization. This page is divided into several areas and tabs.



On the left side is the role management (1), this serves to structure your company organization. Since a
role (2) must be selected for the management of the other functions within the Company area, the role
management is also permanently visible.

Using the tab list (3) on the right you can access the functions Contacts, billing addresses, Shipping
addresses, Budgets and Contingents.

In the individual functions you can then use the filter (4) to determine which entries should be displayed.

Inheritance filter: Will show the entries of the selected role as well as all entries of subordinate
roles.
Assignment filter: Shows all entries assigned to the selected role.

Please note that it is necessary to assign contacts, billing addresses, shipping addresses, budgets and
contingents to a role. Therefore the creation or editing is only possible if a role is selected in the role
management.

Role management

If Easy Mode is activated for the customer account, the Role management are not available.

Roles are used to simplify the configuration, especially when a large number of contacts are involved.
For this purpose you can assign permissions, addresses, budgets and quotas to the roles and then assign
the individual contacts to a role. The contact then inherits the settings of the role.
It is therefore not necessary to make the entire configuration for each contact individually.

To create a new role, click on the Create role button. In the window that opens, give the role a unique
name and click on the Save button. Afterwards the window for the configuration of the role opens.

Assignments

Master data
In the master data you can change the name of the role.

https://docs.shopware.com/en/shopware-6-en/enterprise-extensions/b2b-suite-customer-account#role-management
https://docs.shopware.com/en/shopware-6-en/enterprise-extensions/b2b-suite-customer-account#contacts
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Permission management
Here you specify the permissions for the role.

Using the checkboxes below the check mark (1) in the column All you can assign all available rights
to the role to perform the actions for the respective component. The checkboxes below the arrow (2)
set the right that this role may inherit the rights to further contacts. Inheritance can only be set if the role
also has the right to execute the action.

If certain roles should only receive individual rights for a component, this can be done using the
checkboxes in the respective column.

List (3): The List permission allows to call the corresponding component and display its contents
Detail (4): Allows to call the detail page of individual elements within the component
Edit (5): With this right the existing contents of the component can be edited
Create(6): Allows the creation of new content within the component
Delete (7): The function to delete content in the component is available
Assign (8): Roles/contacts with this right can assign the content of the component to other visible
roles/contacts

Please note that some components have dependencies among themselves. For example, all components
within the Company tab (Contacts, Addresses, Budgets and Contingents) must have at least the right to list
the company and roles. In addition to the permissions, additional visibility is sometimes required.

Contingent management
In the contingent management you get an overview of all available contingents for the role. Please note
that the contingents are inherited from subordinate roles upwards and are also listed. With this it is
possible to assign one or more contingents to the role.



Order list management
The order list management shows all already created order lists and you can assign them to the role.

Budget management
Assign one or more budgets to the role here. The selected budgets can then be used for orders placed by
contacts in this role.

Visibility



Role visibility
Role visibility is needed to select the role for managing the functions in the Company section

Role details view
 

The left checkbox makes the role visible, the right checkbox allows the visibility to be passed on to
other roles or contacts.

Contact visibility
With the contact visibility you define which contacts are visible for members of the role.

Billing addresses
Use this to define which billing addresses are available to members of the role. When ordering, you can
then choose from the available addresses.

Shipping addresses
As with the billing address, the available shipping addresses for the roll are defined here.

Contacts



Contacts are (usually) people within your company structure and get their own store account, where e.g.
orders can be placed. The contact receives the basic rights through the assigned role(s). Additionally,
further rights can be set in the contact's settings. Please note that only additional rights can be set in the
settings of the contact, a restriction of the rights inherited from the role is not possible.

The Contacts tab (1) shows you an overview of the created contacts, depending on the role (2) and
filter (3) selected on the left side. 

With the button create contact (4) you open the mask to create another account. If the button is not
displayed, please check if you have selected a role on the left side.

The button with the pencil  (5) opens the mask for editing an existing contact.

To delete a contact click on the trashcan button (6).

Please note that the contacts are subordinate to the debtor and can only be used in this context. If the
debtor account is deleted, the contacts cannot be used anymore.

Create contact
When you create a new contact, the information of title, first name, last name and e-mail address is
required. Optionally, you can also specify a department.

With Send email for password selection, the contact receives an email with a link that can be used to
set the password for the account. If password activation is not active, a password must be entered to
create the contact.

With the checkbox active you can decide if the account should be active immediately.

With the checkbox Create another contact you can directly create the next contact.



If you check the box create another contact before saving the new contact, the window for creating a
contact will be opened after saving.

The rights management of an account is then done in the window for editing a contact. More details are
found in the next section.

Edit contact
To edit an existing contact, you can click on the pencil icon in the overview list.

Editing a contact works similar to editing a role. For more information see the section Role management.

Billing addresses

In this tab (1) you can store the billing addresses that can be assigned to roles and/or contacts.
However, it is not necessary to create every desired address for a role. You can also assign addresses from
other roles to the role by using the visibility of billing addresses.

https://docs.shopware.com/en/shopware-6-en/enterprise-extensions/b2b-suite-customer-account#role-management


The content in the overview on the right side depends on the selected role (2) and the used filter (3).

To create a new address click on the button create address (4), a new modal will open.

To adjust an existing address, click on the pencil button (5). With the trashcan button (6) you can
delete an address.

Create address
To create a new address, fill out the mandatory fields marked with *. In addition, you can enter optional
information such as the VAT ID and a department name.

The created address is initially only assigned to the role selected at creation. In the role or contact details
you can define the visibility of the address for other roles/contacts.

Shipping addresses

As with billing addresses, it is also possible to create different data sets for shipping addresses in order to
be able to select these in the ordering process.

The functions are identical to the billing addresses and are therefore not explained here.

https://docs.shopware.com/en/shopware-6-en/enterprise-extensions/b2b-suite-customer-account#billing-addresses


Budgets

If Easy Mode is activated for the customer account, the budgets are not available.

Budgets can be used to define how much money certain contacts and/or roles may spend in a definable
period of time before the order has to be approved by a higher instance.

Should there not be a sufficient budget for the order, the order cannot be completed by the customer. In
this case a clearance by a higher instance can be requested. For this purpose, the customer is also
informed by e-mail that an order clearance has been requested.

Depending on the selected role (2) and the filter (3) the corresponding budgets are listed.

You can create a new budget with the button Create budget (4).

Use the pencil icon (5) to open the window for editing an existing budget. You can delete a budget with
the trashcan symbol (6).

Create budget
To create a new budget, some information is required.



For identifiers and names, select a meaningful designation to enable easy identification even if there are
several available budgets.

Enter the desired value to be used for this budget. In combination with the area of validity and the start
of the fiscal year, you define in which period of time and for which amount purchase orders can be made
before a clearance (e.g. by the customer) is required. The validity range "None" means that the budget can
be used once. With the other selection options, the budget is reset at the calculated point in time based on
the start of the fiscal year (e.g. start of the fiscal year 01.01.2020, validity range quarterly; in this case, the
reset occurs on 01.04., 01.07., etc.)
In addition, a responsible contact can be stored, who optionally receives an e-mail if a certain portion of
the budget is used up.

With the checkbox active you define if the budget can be selected and used in the order process.

Contingents

If Easy Mode is activated for the customer account, the Contingents are not available.

Contingents allow restrictions to be placed on orders. For example, the number of products that can be
ordered per order can be specified or certain categories can be excluded.

To create a new contingent click on the button create contingent group

After entering the basic data, you can proceed with the detailed configuration.



In the tab master data the names and descriptions stored in the first step are displayed. The configuration
is done in the tabs Quota rules and restrictions.

Using the contingent rules you can limit the order amount, the number of products ordered and the
number of orders (incorrectly translated as number of products). For example, it is possible that the roles
or contacts to which the quota is assigned, only a certain number of products 
Additionally you can define after which period the quota should be reset. Please note that the calculation of
the period starts with the 01.01. So a quarter runs from 01.01. - 31.03., 01.04. - 30.06. etc.

Order total: Define a maximum amount for which an order can be placed in the specified period
before approval is required.
Number of ordered products: Define how many products can be ordered within the period. Products
are defined here as the positions within an order. This means that if the same product is ordered 3
times in one order, only one product will be counted.
Number of products (wrong translation) / number of orders: Allows you to limit the number of orders
that can be processed in the given period.

The contingent restrictions allow the limitation to certain products or categories. The following types are
available for this purpose:

Product price (exclusion): Set the maximum product price. All products that are more expensive
cannot be ordered directly
Product number (exclusion): The product number stored here cannot be ordered directly. To exclude
multiple product numbers, set several restrictions of type 
product number (exclusion) on.
Product numbers (clearance):
Category (Exclusion): Exclude products from the direct order that are assigned to the corresponding
category.

Please note that a contingent must always contain at least one contingent rule, otherwise only an order
clearance request is possible.



Statistics

The statistics offer various options for evaluating the placed orders.

The diagram provides a graphical representation of the orders. For more details you can hover over the
diagram with your mouse, a popup (1) will appear.

In order to view the statistics, you need to have the List right for the orders.

Filter

The filters affect the diagram, the overview list and the export

With the date selection (1) you can define for which time frame the data should be evaluated (diagram
and overview list).
With the selection at Group by (2) you can decide whether the diagram is displayed weekly, monthly or
yearly.
The filters  allow you to restrict the data that should be considered for the statistics. For example, you can
specify that only orders from individual roles (3) or orders with a certain status (4) are displayed. With
Reset filter (5) you can reset your selection. Use Apply Filter (6) to apply your selection to the current
view.

In the selection filters only data is shown for which there is an authorization or visibility and for which there
is at least one order.

In addition, the orders are listed in an overview, which you can export in CSV or XLS (7).

Orders

In tab Orders you see an overview of the existing orders as well as orders that are waiting for clearance.

Completed orders



In the first overview the already placed orders are listed. The content of the overview depends on the
permissions of the account you are logged in with.

For sorting there are several options available. Furthermore it is even possible to search for orders.
In the overview you can immediately see the relevant information about the orders.
You can access the order details by clicking on the pencil symbol, where you can see the invoice and
delivery details as well as the ordered products.
You can also use the list symbol to create an order list from your order, so that you can add it to your
shopping cart more quickly in the future. You can find more information in the section Order lists.

Order details
The order details are divided into several sections for a better overview.

General information
The General information shows the general information as well as the details of the delivery and invoice.

Positions
Here you can see the products that are included in the order.

https://docs.shopware.com/en/shopware-6-en/enterprise-extensions/b2b-suite-customer-account#order-lists


History
Changes to the order are documented here. These are status changes and you have the option to add
additional information.
For already completed orders you have the option to add comments in the master data.

Order clearances

Orders that cannot be completed by the contact (e.g. due to lack of budget or restrictions due to
contingents) require approval from a higher instance with appropriate authorization. For a better handling
of these approvals, they are also listed in a separate list in addition to the normal overview.

Here you can also use the functions for sorting (2) and searching (1).In the list (3) you can see the
most important information at a glance.
For more information about a single order please click on the pencil icon (4) to see the details.
With the check symbol (5) you release the order, with the X symbol (6) the release is rejected. Another
window will open where you can add an optional comment to the rejection and confirm the rejection by
clicking the button Reject Order.
Rejected orders will remain visible in the order overview with the status release rejected.
If you want to remove the order completely, you can delete the order by clicking on the trashcan symbol
(7) instead of the rejection.

Order details
With a click on the pencil symbol you open the details of an order. This window is divided into several
sections.

Master data
The Master Data section brings together basic information such as delivery and invoice information.



Products
The products to be ordered are listed here. If an order has not yet been released, it is possible to adjust the
individual items of the order or to add further products.

To add another product, click on the add product button (1). A window will open where you can search
and add the desired product by its product number.
You can edit existing positions by clicking on the pencil symbol (2) to change the number of products.
With the trash can icon (3) you can remove an item completely from your order.

Order lists

Order lists provide you with the ability to plan different orders or to easily manage frequently needed
items.

To create a new order list, click on the button Create order list (1). More information about this can be
found in the next paragraph Create order list.
You can sort (3) the order lists for a better overview (4) or search (2) for specific order lists.
To edit an orderlist open the details by clicking on the pencil symbol (5). You can find more information in
the section Edit order list.
With the shopping cart icon (6) you can add products from the order list directly to the shopping cart.
To duplicate an order list, click on the plus symbol (7).

https://docs.shopware.com/en/shopware-6-en/enterprise-extensions/b2b-suite-customer-account#create-order-list
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Order lists containing products can be exported as a CSV file by clicking the cloud symbol (8). As
separator "," (comma) is used. The file contains information about product number and quantity. This
format is also used for fast orders.
Order lists that are no longer needed can be deleted by clicking on the trashcan symbol (9).

Create order list

If are creating a new order list, a window will appear where you need to enter a name for the order list and
optionally assign a budget.

After you have saved the basic details, the order list will be created and can be accessed from the overview
with the pencil symbol for further editing. This is also where you can add the desired products to the order
list.

You can also create order lists directly on a product detail page. How this works in detail, you can read in
the section order lists on the product detail page

Edit order list

You can access the edit mask of an order list from the overview by clicking on the pencil symbol. Here you
have the ability to add products to the order list

https://docs.shopware.com/en/shopware-6-en/enterprise-extensions/b2b-suite-customer-account#fast-orders
https://docs.shopware.com/en/shopware-6-en/enterprise-extensions/b2b-suite-customer-account#order-lists-on-the-product-detail-page


In the products section you will find an overview of all products assigned to the order list.

In the Products section you will find an overview of all products assigned to the order list.
With a click on the button Add new position the view changes to add another item to the order list. Here
you can use the input field in the Product name and Product number columns to search for individual
products and add them directly. As soon as you enter the name or number of the product in one of the
fields, the matching product will be searched and suggested.

You can remove an item from the order list with the trash symbol (4).

Fast orders

The fast order function allows you to add products to the shopping cart or an order list with only the
relevant data, such as product number and quantity.
This can be done either directly using a simple input mask or by importing a file.

In the input mask (1) simply enter the product number (2) and the desired quantity (3).
After you added a product, a new line will be displayed to enter another product..



If at least one product is available in the list, the functions for adding to an order list (4) or to the
shopping cart (5) are available.

File upload

To add products from a prepared file, the following file formats can be used: CSV, XLS and XLSX.

You can either drag and drop the file you wish to upload into the dotted area (1) or click once with the
mouse to open the file selection window.
The default structure of the file is as follows:
Store the product numbers in the first column and the desired quantity in the second column. Use ","
(comma) as separator.

If you wish to use a different file structure, you can make adjustments in the advanced settings (2).
Define in which column the product number (3) and the quantities (4) are entered and which
separator (5) should be used.
You can also define an additional capsule character. This is needed for CSV files if the separator is used
within a column. With the capsule character the separator is commented out to ensure the correct
formatting.
If there is a heading in the first line of the file, you can mark this with the checkbox The file includes a
row with headings. This line will not be imported.

After the upload is completed, the items are added to the lower list. You can then process the data as
described above.

Offers

Under Offers you will find an overview of the requested offers.
You can find out how to make an offer request in the request offer section of the order confirmation.

https://docs.shopware.com/en/shopware-6-en/enterprise-extensions/b2b-suite-customer-account#offer-request-in-the-order-confirmation


In order to edit an offer,  accept or reject it after feedback from the shop operator, click on the pencil
symbol (1). The modal with the offer details will be opened. If you want to remove an offer completely,
you can do so by clicking on the trashcan symbol (2).

Accept offer

If the shop operator agrees to your request for a quote, you can place an order from within the offer.
To do this, call up the offer details (pencil symbol in the overview).

It is then necessary to conclusively accept the offer in the master data area by clicking the button Accept
offer.

This will convert the offer into an order and you will be forwarded to the order completion. There you can
now buy the products available in the offer at the negotiated conditions.

Edit offer

After accessing the offer details from the overview, you can make changes to the offer there.



The first step to be able to make changes is to decline offer.
By clicking the button accept offer you can buy the products at the conditions confirmed by the shop
operator. You will receive further information on this in the accept offer section.

In the positions section you can then change the offer.

In the top part of the modal you will be shown an overview of the original prices (2) and the offered
prices (3).
You can add new products (1), as well as change the quantity and price (4) of existing products.
You can remove a position from the offer using the garbage can symbol (5).
You can also define or adjust an absolute or percentage discount (6) for the entire offer.

The comments section lists all comments made about the offer.

https://docs.shopware.com/en/shopware-6-en/enterprise-extensions/b2b-suite-customer-account#accept-offer


Information about the changes in the offer can be found in the history section.

Order numbers

In the order numbers section you have the option to store your own order numbers. You can then use your
own order numbers in parallel to the default order numbers from the store. You can either maintain the
order numbers manually through the list or by importing a prepared file.



Enter the store product number (1) and the desired own product number (2) into the input mask.
After adding a product number, a new line will be displayed to enter another number.
The entries will be saved automatically.

File Upload

Especially when dealing with large amounts of data, it may be easier to use the upload function rather than
manually entering all the data. With the upload function you can import the numbers from a CSV or XLS(X).

The structure of the file is simple. The first column contains the standard order number, the second column
contains the own order number.
To upload the file, you can drag and drop it into the dotted area (1) or click once with the mouse to open
the file selection window.

Determine in which column the existing product number (3) and the own product number (4) are
entered and which separator (5) should be used.
You can also define an additional capsule character (6). This is required for CSV files if the separator is
used within a column. With the capsule character the separator is commented out to ensure the correct
formatting.
If there is a heading in the first line of the file, you can mark this with the checkbox This file includes a
row with headlines (7). This line will then not be imported.

You also have the option to export the previously stored order numbers as CSV or XLS.

CAUTION! The import exchanges all existing data. If there are own product numbers in the list, make an
export and use the exported file to add the additional own product numbers. Loss of data is possible, when
uploading a file without the existing data.

Functions in a normal shop context

The B2B-Suite provides some functions that have an impact on other store areas (product detail page,
order process).

Table views



If you are logged in as a B2B account, you have the option of switching to a table view in addition to the
normal listing view.

To change the view, a button (1) has been added below the filters.

In the table view you have the ability to add one or more products directly to the shopping cart.
Enter the desired quantity (2) for each product and then click on the button add to basket. You can also
enter several products before clicking the button.

Order lists on the product detail page

If you are logged in with a B2B account, you can add products to an order list directly on the details page.

Open the drop-down (1) and select one of the existing lists (2) or create a new one. To do so click
create order list (3), now use the input field to name the order list. After saving the name the order list
will be created and the product will be added.

Budgets and order lists in order completion



For B2B accounts it is necessary to select a budget when ordering. If there is no (sufficient) budget
available, the order cannot be completed by the customer and a request for order release is required.
In addition, before completing the order, the shopping cart items can be added to an order list so that they
can be reordered later.

A separate section (1) is added to the overview for the budget. If there are different budgets for them,
you can select the appropriate budget here (2). On top of it you can see the identifier and name (3)
as well as the available amount and spend percentage (4) of the selected budget.

Beneath the products in the shopping cart you have the opportunity to add the shopping cart to an
order list (5).

Offer request in the order confirmation

A debtor or B2B contact has the option of requesting an offer for the items in the shopping basket on the
order completion page. For this purpose, the button request offer(1) can be found underneath the button
submit order for authorized contacts..



A modal will then open, in which you can enter the desired information for the offer. From this moment on,
the offer is also available in your account in the section offers.

First you have an overview of the original price of the shopping basket (1). On the right side the price
requested through the offer is shown (2). This is calculated from the requested discount (3)
(absolute or percentage) as well as the product prices that may have been adjusted..

You have the option of adding more products (4) as well as adjusting the quantity and the desired
price of the existing products (5). If you want to remove a product from the request for quotation, you
can do so by clicking on the trashcan symbol (6).

Before you send the request for quotation (8), you may optionally add a comment (7) in order to
provide the shop operator with relevant information about the offer.

Further handling of the offer takes place in the offers section of the shop account.

Performance increase in the shopping cart as of Shopware
6.4.11.0

As of Shopware 6.4.11.0, you have the option to increase the performance in the shopping cart by
activating Redis. This is recommended if there is a large amount of data (several hundreds of products) in
the shopping cart. You can find instructions on how to do this in the developer documentation.

CMS extensions for Shopware 6

The CMS Extensions for Shopware 6 is a extension that is part of Shopware Evolve and provides extended
functions for the shopping experiences.

https://docs.shopware.com/en/shopware-6-en/enterprise-extensions/b2b-suite-customer-account#offers
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Installation

If at least the Shopware Evolve plan is stored for the store domain in the Shopware account, you can
download and install the extension under Extensions > My Extensions.
It is important that you have previously logged in with your account in the Shopware Account tab. 
After the extension has been installed, you can activate it using the button to the left of the extension.

Functions

The following functions are provided by the extension:

Quickview

This function enables a product view directly in the listing.
This means that the customer does not have to leave the Listing to get a more detailed overview of the
product.

Activation
The activation of the function is possible in the respective shopping experience and is available for the
following elements of the commerce type: "Three Columns, Product Boxes", "Product Slider" and "Cross
Selling".
If you have selected a corresponding element in the shopping experience editor, you can activate
quickview (1) under item behavior.
This will then be used in all categories to which this shopping experience is assigned.

Frontend view



Quickview in search results

You can also activate this product view for the search results.

Activation
This function can be activated directly in the configuration of the extension. To do this, go to your
extensions in the administration and open the configuration of the CMS extension using the three dots on
the right-hand side. You can then activate and save the function.

Frontend view

Scroll-Navigation

The scroll navigation provides you with the opportunity to set navigation points in an shopping experience.
Based on these navigation points, a navigation menu is displayed on the left side, which allows you to jump
directly to the individual sections. In addition, the sections can be accessed directly by using the URL



parameters.

Activation
A navigation point can be created for each section in the shopping experience. For this purpose the
extension provides a new section Scroll Navigation in the section settings.

To assign a navigation point, first open the section settings using the symbol on the left side of the
section (1). On the right side you can now unfold the configuration of the Scroll-Naviation (2). There
you can activate the navigation point (3) and assign a name (4). If the navigation point is activated,
an additional symbol is shown on the left side (5). This allows you to see directly whether the
navigation point is active for a section.

We recommend that the individual section should at least fill the screen, using a smaller section could lead
to inaccurate jumping to the desired section.

Animated scrolling
This function will enable animated& crolling when jumping to a navigation point.
If at least one navigation point is set in an shopping experiences, animated scrolling (2) can be activated
in the settings of the shopping experiences (accessible through the gearwheel symbol) in the item Scroll
navigation (1).

For individualisation you can choose from different scroll behaviours (3) and set an animation duration
(4). Besides the scroll behaviour constant (linear) there are other settings (5) available.
The elastic scrolling (6) is an animation, which lets the picture "jump" a little bit before and after the
scrolling process.
Alternatively you can adjust the degree of the course curve (7). This value controls the acceleration or
deceleration of the scrolling (not with constant (linear) or active elastic scrolling).



Frontend view - desktop

The navigation bar (1) is located on the left side to get to the individual navigation points.
If you use the mouse pointer to hover over one of the navigation points, the name of the section will be
displayed.

Frontend view - Mobile

In the mobile view, the navigation menu is located at the bottom right.
With the arrow button (1) you can jump between the individual navigation points.
Use the button with the 3 dashes (2) to expand the menu.



In the expanded overview (1), the individual sections are now listed with their respective names.

Call by URL parameter
It is possible to call up a navigation point directly from a URL parameter. The name of the navigation point
is used for this.
In our example, the name of the navigation point is "Lorem Ipsum". The call is made using the URL
https://your-shop.com/Test-Landingapge/#lorem%20ipsum

Define visibility of individual blocks

The extension provides a function to control the visibility of individual blocks of a CMS page using the rule
builder rules.

https://docs.shopware.com/en/shopware-6-en/settings/rules
https://docs.shopware.com/en/shopware-6-en/settings/rules


Block (1): To change the settings select the disired block.
Block settings (2): This opens the block settings on the right side.
Visibility (3): define the visibility of the block.
Rule builder rule (4): By default the block is alway visibile, Select a rule to define when the block will be
hidden.
Visible, if rule does not apply (5): If this is active the set rule will be reversed.

Individual forms

In addition to the default form, you can also add your own individual forms to the shopping experience with
the CMS extension for Shopware 6.

To add a form to your shopping experience, click on Content > shopping experience and select the
shopping experience to which the form is to be added. Then click on the + symbol to add a new block and
select form as the block category. In addition to the default form, e.g. for the contact, you can now also
drag your own form into your shopping experience.

A pop-up window opens, this gives you the option to use a previously created template or to create a new
form.

Even if you use a template, you can still edit it completely afterwards.

Options

When you create a new form or edit an existing one, the form settings window opens with the tabs
options and fields. The basic settings for the form are made in the options tab.



Name (internal) (1): Enter the internal name of the form. For example, if you save the form in the
templates, this name will be used.
Headline (2): The headline is used in the shopping experience, i.e. in the forntend, as the headline for the
form.
Confirmation text (3): The confirmation text is displayed to the user as soon as he has filled in the form.
Recipient address (4): Enter all e-mail addresses to which the filled out form should be sent. Multiple
addresses can be entered simply by pressing the Enter key once after each address.
E-mail template (5): Select the e-mail template to be used for sending the form content to the recipient
addresses.

Fields

In the Fields tab you can specify which fields can or must be filled in by the user. To do this, you can create
groups that contain one or more fields.



Group (1): On the left side you see the groups of the form. You can use the dots on the left to change the
order of the groups by drag and drop.
Group context menu (2): On the right side of each group you can rearrange its position, delete it or
duplicate it. You can also edit the group so that further options for the group are displayed on the right-
hand side of the screen. Here you can enter the internal name of the group and you can change the
heading of the group. The heading is also displayed in the frontend.
Field (3): The fields are located within a group. You can change the order of the fields within the group by
drag and drop using the dots on the left.
field context menu (4) on the right side of the field, you can rearrange its position of the field, move the
field to another group, duplicate it or delete it. You can also edit the field there so that further options for
the field are displayed on the right side of the screen.
Add field (5): Adds a new field within the respective group.
Add group (6): Use this button to add a new group including a field.
Options (7): Depending on whether you are currently editing a group or a field, you will find further
options for the respective group or field on the right-hand side.
If you are editing a group, you will see the information Name (Internal) and Heading. The heading is visible
in the frontend, while the internal name serves as an internal identification. E.g. as a variable in e-mail
templates.
You can see which options are displayed here when you edit a field.
Save as template (8): With this button you can save the form you have just created as a template. These
templates can be edited and selected in your shopping experience.
Done (9): To save all changes in the current form, click on done.

Field options

When you edit fields, you will see the options you can edit on the right hand side. The possible options
differ depending on the type of field you are editing. However, the following options are always available
for each type.



Name (1): The Internal Name serves as a unique identification for the use of this field as a variable. E.g. in
e-mail templates.
Title (2): This name is displayed on the form in the frontend.
Type: (3): Select the type that the field should have. This type determines which values can be entered in
the field and how they should look. We have listed the available types below.
Width (4): Here you define how wide a field should be. If two subsequent fields together use a maximum
of 100% of the width, they are displayed next to each other in the form. This is useful, for example, if
information is to be entered in two fields, but the content belongs together. E.g. street name and house
number.
Required field (5): Indicates whether the field is mandatory or not.
Error message (6): This message is displayed to the user in the frontend if a mandatory has not been
filled in.

Text field & email field



For the field type Text or E-mail, you can specify a placeholder text to be displayed if the field has not yet
been filled in.

Number field

For fields with the type number, you can optionally specify whether there should be a minimum or
maximum limit. You can also specify the steps in which the user can enter numbers. If you enter a 3 here,
for example, the user can only select numbers 3, 6, 9, 12, 15, etc....

Selection field

The selection field is a checkbox that the user can activate or deactivate. In the default value you can
specify whether the field should already be activated by default or not.

Selection



The selection type offers the user a predefined selection to choose from. Using content = entity, lets
you select in the second step, from which shop entity the user can make a selection.
Using content = user-defined, lets you enter values in the second step, from which the user can then
choose. Type the values into the field values and press the enter key.

Text area

The text area is used to enter a longer text. In addition to the placeholder text, you can also specify how
many lines the user may use and whether the user may change the size of the text area.

Custom Products

Products for Shopware 6 is an extension that is part of the Shopware Rise plan.

The extension offers you the possibility to add individualization options to articles. This is very useful for
articles where the simple division into variants is not sufficient and further individualization is desired.
These can be articles where an individual lettering is to be used, a special color or a certain date/time
specification.

In the extension Custom Products you create product templates with selectable options. In a second step,
you link these templates to existing articles. The selectable options from the product template are then
displayed on the item detail page so that the customer can individualize the product accordingly.

Optionally, you can freely add user-defined charges to the specific options.

Installation



If at least the Rise Plan is stored for the store domain in the Shopware account, you can download and
install the extension under Extensions > My Extensions.
It is important that you have previously logged in with your account in the Shopware Account tab.
After the extension has been installed, you can activate it via the button to the left of the extension.

You can find the installed extension in the Shopware Administration under Catalogues > Custom
Products.

Product templates

Under Catalogues > Custom Products you will find the overview of the product templates.

Here you can see all the templates that are already created, these can be assigned to your products. Each
template has an internal name, a display name and a description. In addition, the overview shows you
how many options each template has. 
You can edit, duplicate and delete the templates through the context menu on the right side.

Add template

You can create a new template by clicking the button Add template. Here you set the  general
configuration.



Internal name (1): This name is only displayed internally in the template overview. This is useful if there
are several product templates that should have the same name in the front end.

Active (2): With this switch the product template can be deactivated. The articles in which this template is
used are still available, but cannot be individualized with this template.

Display name (3): This name is used in the frontend on the article detail page.

Description (4): With this description you can summarize on the item detail page for the customer which
individual settings can be added to the respective item.

Picture (5): Additionally you can upload a picture for the item detail page or select one from the media
management.

Step-by-step mode (6): With the step-by-step mode, the customer is guided step-by-step through the
options in the front end, instead of being shown all at once.

Self-collapsing options (7): This function collapses options as soon as the customer has made a valid
entry. (Not available in step-by-step mode)

Customers need to confirm their configuration (8): Here you can define whether customers have to
confirm their configuration by checking a box on the product page or not. As long as the checkbox is not
activated when the function is active, it is not possible to add the product to the shopping cart and the
button "Add to cart" is grayed out.

Options

After you have created a new template and saved it, the Options area is available.



In this area you will see the options that are available for the current template. You can also add new
options for customization here.

<

Here you first enter a name for the option and an option type. The following option types are available:

Selection field

In this option type, you can offer the customer one or more selection options, which are then made
available in a window and can be selected by mouse click. For example, these can be individual options
that can be added to the product.

In the settings of the option you first choose a name (1), this name will be displayed in the storefront and
in the order documents.
If you check the mandatory field (2), the customer has to make a choice in the frontend to be able to put
the item into the shopping cart. The option No selection is then no longer displayed in the frontend.
In addition, you can optionally enter a description (3) to provide the customer with further information
about this option.



Next, you can specify that the selection options should be displayed as a drop-down menu (4) and
whether a multiple selection (5) should be possible. However, multiple selection is not possible in the
dropdown menu.

Optionally you can add a surcharge that the customer has to pay when selecting the option.For more
information, see the section defining option-dependent surcharges.

On the left side of the option settings you can see the created items that the customer can select. With the
button Create element (6) you can add further elements. If you click on one of the elements (4), you
have the possibility to make further settings for the element.

In addition to a name and an order number, you can define your own surcharge here, just like in the
option settings. The surcharge of an element is calculated in addition to the surcharge of the option.

Display in the frontend: 

If it is a mandatory option, the No selection element is not available.

Display in the frontend as drop-down menu: 

https://docs.shopware.com/en/shopware-6-en/catalogues/customproducts#define-option-based-surcharges


If it is a mandatory option, the No selection element is not available.

Image upload

The image upload offers the possibility for your customers to upload their own images, e.g. to use them to
individualize the product. The following image formats are supported in version 3.1: JPG, PNG, GIF,
WEBP, SVG, BMP, TIFF and EPS.
These image formats are partially only available in the Admin.

First give a name (1) to the option. The name will be displayed in the storefront and on the order
documents. The checkbox Mandatory field (2) allows you to determine whether the customer must make
a mandatory entry.
With the optional description (3) you can give your customers more information about the option.
In addition, you can enter an order number (4) for the option, which will then be printed on the
documents.
For the configuration of the option, you need to specify the maximum number of files (5) and
maximum file size (6).



For more information, see the section defining option-dependent surcharges.

Frontend view of the image upload:

As file types jpg, png and gif can be used.

Access the uploaded files:

The uploaded images are saved in the order. In the admin you can call up the custom product configuration
in the order in the section items via the "..." menu. 

The configuration information is displayed in a new modal and gives you the option to download the
uploaded files.

Picture selection

Compared to the selection field, the image selection offers you the possibility to make a selection based on
images. The image selection has the exact same settings as the selection field. The only difference is that
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additional elements ar shown in the image and cannot be displayed in a drop down menu.

Frontend view of the picture selection:

If it is a mandatory option, the No selection element is not available.

Checkbox

With the checkbox you can offer your customers an option, which they can select or deselect with
the checkbox. Here you can enter an order number next to a name and a description and add a
corresponding surcharge.



Frontend view of the checkbox: 

File Upload

The file upload offers the option to upload PDF files. 



The configuration of the file upload is identical to the image upload.

Frontend view of the file upload:

Date field

With the date field you give the customer the possibility to add a date to the order. This can be, for
example, a date for an engraving or an event date.

https://docs.shopware.com/en/shopware-6-en/catalogues/customproducts#image-upload


Beside the usual settings for this option, you enter a placeholder (1) which is displayed in the date field
before the customer has selected a date. You can also specify an earliest date (2) and a latest date (3).

Frontend view of the date field:

Colour selection

With the colour selection the customer has the possibility to choose one or more colours for the article.
Similar to the selection field or the image selection, you can also add sub-elements to the colour selection
option, each of which stands for one colour.



After you have added one or more sub-elements to the option on the left side, you can assign a color (1)
to the element in addition to the name and order number. You can also define a surcharge for the
colour selection for the complete option as well as for the individual elements.

Frontend view of the colour selection:

If it is a mandatory option, the No selection element is not available.

HTML editor

The HTML editor offers the possibility to enter a text with simple formatting functions. The text entered is
transmitted in the same form when the order is placed, no conversion takes place.



Apart from the name for the option, no further mandatory information is required.
Optionally, the entry can be marked as a mandatory option in the HTML editor. In this case, the customer
can only add the product to the shopping cart if he or she has made an entry.
In addition, a description can be stored to provide the customer with further information.
The option product number can be optionally maintained and is then shown in the order confirmation and
invoice.

Information about the possible surcharges for the option can be found here.

Frontend view of the HTML editor:
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Access to the data entered by the customer:

You can see the customer's entries in the order in the corresponding position. You can call up the
configuration using the "..." menu.

Text area

The text area lets the customer add text to the article. Compared to the text field, the text area will take
pagination into account. The customer has the possibility to transfer multi-line texts here.



Here you need to specify how short (2) or how long (3) the text entered by the customer may be. You can
also specify a placeholder (1), this will be displayed as long as the customer has not yet entered any text.

Frontend view of the text area:

Text field

With the text field you offer the customer the possibility to add a single-line text to the article. This can be
the text for an engraving or similar.



To do this, you specify how short (2) and how long (3) the text may be at most. As with the text area, you
also enter a placeholder (1), which is displayed as long as the customer has not yet entered any text.

Frontend view of the text field:

Number field

The number field add the possibility for the customer to add a number to the product. This can be, for
example, the number of a certain item.



The minimum value (1) and maximum value (2) indicate which data can be entered in this field by the
customer
The step size (3) determines the steps in which the numbers can be entered. Decimal places are also
possible. Example: Step size 0.5 - Inputs 0; 0.5; 1; 1.5; 2; 2.5 etc. can be used.

The default value (4) indicates which value is pre-selected 

Frontend view of the number field:

Time field

In the time selection field you can let the customer specify a time. This could be the start time for an event,
for example.



The placeholder (1) indicates how the field is filled before the customer enters it. In addition, you use the
start time (2) and end time (3) to specify the period of time in which the customer may select a time.

Frontend view of the time field:

Define option-based surcharges

You have the ability to define additional surcharges for each option. To do this, you can use the
corresponding functions in the configuration of the individual options to levy either absolute or relative
surcharges.

Absolute surcharges



Use the Relative surcharge button (1) to switch between entering absolute and relative surcharges for
the selected option. However, only one of the two types of surcharges is available for each option.

Before you can enter the amount of the surcharge, it is necessary to select the tax rate (2) for the
surcharge. Then you can enter the gross price (3). If the lock symbol is closed between gross and net
price (4), the net price will be determined automatically based on the values entered. To enter a different
net price, click once on the lock symbol to open it. The net price is no longer bound to the gross price.

The extended surcharge (5) is only available for absolute surcharges after selecting a tax rate and offers
you the possibility to define your own surcharges for the different currencies stored in the shop using rule
builder.

With the checkbox Surcharge once per order (6) you can determine whether the surcharge should only
be calculated once in an order, even if the option is used several times.

After you have selected a tax rate, the function of currency dependent prices (7) is also available. Here,
you can define a separate surcharge for each currency stored. In the standard system, the price of the
standard currency is inherited and calculated using the conversion factor stored in the currencies. If you
want to define different surcharges for a currency, you can cancel the inheritance by clicking on the chain
symbol in front of the currency name and enter your own surcharge.

https://docs.shopware.com/en/shopware-6-en/settings/rules
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Relative surcharges

Relative surcharges are calculated dynamically based on the product price and the stored percentage rate
for the surcharge.

To use a relative allowance, activate the Relative allowance check box (1).

To calculate the surcharge, store a tax rate (2) and the relative surcharge (3).

If you want to use more detailed configurations for the surcharge, you can activate the Extended
Surcharge (4).
Here you have the option of defining different surcharges using rules that are setup with the rule builder.

https://docs.shopware.com/en/shopware-6-en/settings/rules


With the checkbox Surcharge once per order (6) you can determine whether the surcharge should only
be calculated once in an order, even if the option is used several times.

Exclude options from each other

If you have created at least 2 options, which are not marked as mandatory options, the possibility for
mutual exclusion of options is shown.

To create an exclusion combination, click the Add excluded combination button. In the modal that now
opens you can do the further configuration.

First, give a name for the combination, so that you can later on recognize, what you have configured here.

For the actual configuration you can now choose from the options that are not mandatory or multiple
options.
With these options you can also choose whether the exclusion should take place if the customer has made
an entry there or if the field is empty. Thus it is also possible to combine options with each other and to
require an entry in one field if another field has also been filled.

Assign template to a product



After you have created a template with the desired options, you can assign it to a product so that the
customer can individualize this product.

To assign the product configuration to a spefic product so that this can be individualization. In the tab
Specifications you will find the menu item Custom Products, where you can now assign a product
template from Custom Products.

Frontend
Normal mode

In the frontend the options from Custom Products are displayed in the standard respsonsive theme above
the Add to shopping cart button.

Here, the individual options of the product template can be folded out (1) and edited individually by the
customer.
If an option is a mandatory field (2), this is displayed accordingly. Any surcharges (3) for an option are
also displayed. (Surcharges for an element within an option are displayed next to the element). If a
customer has selected an option or an element with a surcharge, this is summarized in the Per Unit
Surcharges (4) overview below. The customer now has the possibility to share the configuration of a
Custom Products product via link (5). In addition, the button can be used to determine whether this link
can only be called up once or not.

Step by step mode



If you have activated the step-by-step mode in the product template, the available options are not directly
displayed in the frontend. Instead, the area for customization (1) of the product is located above the In
the shopping cart button. By clicking on the Configure product button (2), the customer is then
guided step by step through the options. If a customer has selected an option or an element with a
surcharge, this is summarized in the Per unit surcharges (3) overview below. The customer now has the
possibility to share the configuration of a Custom Products product via link (4). In addition, the button can
be used to determine whether this link can only be called up once or not.

The customer is guided step by step through the options and can then place the item in the shopping cart
once all mandatory options have been filled out.

Display of Custom Products options on the invoice

The individual Custom Products options are listed as separate items in the accounts. If you have assigned a
separate product number for the option, this is also displayed.



If you want to further customize the invoice and other documents, it is necessary to customize the
document template. You can find all information about this in our detailed developer documentation.

Customise order confirmation

By default, the order confirmation that the customer receives by e-mail lists all options, indicating which
Custom Products options the customer has selected. In the standard template, all options are listed in the
order confirmation that the customer receives by mail, which Custom Products options the customer has
selected. As of extension version 3.1.1, the exact contents such as the text in the text field, the number in
the number field or the selected date from the date field are also output in the standard template in the
invoice and the order confirmation. Nevertheless, adjustments are possible here in the e-mail template of
the order confirmation.

If you are using a version of the extension older than 3.1.1, these adjustments are necessary so that the
Custom Products details are displayed in the order confirmation and in the invoice.

In the standard email template, the individual custom product options are listed as a single item. This is
made possible by a for loop, which creates a new row for each option. The table with the integrated for
loop looks like this in the standard HTML e-mail template:

<table width="80%" border="0" style="font-family:Arial, Helvetica, sans-serif; font-size:12px;">
    <tr>
        <td bgcolor="#F7F7F2" style="border-bottom:1px solid #cccccc;"><strong>Pos.</strong></td>
        <td bgcolor="#F7F7F2" style="border-bottom:1px solid #cccccc;"><strong>Bezeichnung</strong></td>
        <td bgcolor="#F7F7F2" style="border-bottom:1px solid #cccccc;"><strong>Menge</strong></td>
        <td bgcolor="#F7F7F2" style="border-bottom:1px solid #cccccc;"><strong>Preis</strong></td>
        <td bgcolor="#F7F7F2" style="border-bottom:1px solid #cccccc;"><strong>Summe</strong></td>
    </tr>

    {% for lineItem in order.lineItems %}
    <tr>
        <td style="border-bottom:1px solid #cccccc;">{{ loop.index }} </td>
        <td style="border-bottom:1px solid #cccccc;">
          {{ lineItem.label|u.wordwrap(80) }}<br>
            {% if lineItem.payload.options is defined and lineItem.payload.options|length >= 1 %}
                {% for option in lineItem.payload.options %}
                    {{ option.group }}: {{ option.option }}
                    {% if lineItem.payload.options|last != option %}
                        {{ " | " }}
                    {% endif %}
                {% endfor %}
                <br/>
            {% endif %}
          {% if lineItem.payload.productNumber is defined %}Artikel-Nr: {{ lineItem.payload.productNumber|u.wordwrap(80) }}{% endif %}
        </td>
        <td style="border-bottom:1px solid #cccccc;">{{ lineItem.quantity }}</td>
        <td style="border-bottom:1px solid #cccccc;">{{ lineItem.unitPrice|currency(currencyIsoCode) }}</td>
        <td style="border-bottom:1px solid #cccccc;">{{ lineItem.totalPrice|currency(currencyIsoCode) }}</td>
    </tr>
    {% endfor %}
</table>

In order to output the corresponding content for each selected Custom Products option, you can insert the
following code at the appropriate place.

https://developer.shopware.com/docs/guides/plugins/plugins/checkout/document/add-custom-document


            {% if lineItem.payload.type is defined %}
    {% if lineItem.payload.type == "textfield" %}
        {{ lineItem.payload.value }}
        <br/>
    {% elseif lineItem.payload.type == "textarea" %}
        {{ lineItem.payload.value }}
        <br/>
    {% elseif lineItem.payload.type == "numberfield" %}
        {{ lineItem.payload.value }}
        <br/>
    {% elseif lineItem.payload.type == "datetime" %}
        {{ lineItem.payload.value|date("Y.m.d") }}
        <br/>
    {% elseif lineItem.payload.type == "timestamp" %}
        {{ lineItem.payload.value|date("H:i:s") }}
        <br/>
    {% elseif lineItem.payload.type == "htmleditor" %}
        {{ lineItem.payload.value }}
        <br/>
    {% elseif lineItem.payload.type == "imageupload" %}
            {% for media in lineItem.payload.media %}
                {{ media.filename }} <br/>
            {% endfor %}
        <br/>
    {% elseif lineItem.payload.type == "fileupload" %}
            {% for media in lineItem.payload.media %}
                {{ media.filename }} <br/>
            {% endfor %}
        <br/>
    {% endif %}
{% endif %}

As you can see, the code contains a separate if- or ifelse query for each possible custom products option.
For the options selection field, image selection, checkbox and colour selection, no specification of
the content is necessary. Here, the customer selects an already existing selection, the name of which is
output in the respective position.

Example in the default e-mail template

If you insert the code into the default HTML email template, the template will look like this:

<div style="font-family:arial; font-size:12px;">

{% set currencyIsoCode = order.currency.isoCode %}

Hello {{order.orderCustomer.salutation.letterName }} {{order.orderCustomer.firstName}} {{order.orderCustomer.lastName}},<br>
<br>
We received your order on {{ order.orderDateTime|date }}.<br>
<br>
Order number: {{ order.orderNumber }}<br>
<br>
As soon as payment is received, you will receive a separate notification and your order will be processed.<br>
<br>
You can check the current status of your order at any time using this link: {{ rawUrl('frontend.account.order.single.page', { 'deepLinkCode': order.deepLinkCode}, salesChannel.domains|first.url) }}<br>.
You can also use this link to edit the order, change the payment method or make a payment afterwards.<br>
<br>
<strong>Information on your order:</strong><br>
<br>

<table width="80%" border="0" style="font-family:Arial, Helvetica, sans-serif; font-size:12px;">
    <tr>
        <td bgcolor="#F7F7F2" style="border-bottom:1px solid #cccccc;"><strong>Pos.</strong></td>
        <td bgcolor="#F7F7F2" style="border-bottom:1px solid #cccccc;"><strong>Bezeichnung</strong></td>
        <td bgcolor="#F7F7F2" style="border-bottom:1px solid #cccccc;"><strong>Menge</strong></td>
        <td bgcolor="#F7F7F2" style="border-bottom:1px solid #cccccc;"><strong>Preis</strong></td>
        <td bgcolor="#F7F7F2" style="border-bottom:1px solid #cccccc;"><strong>Summe</strong></td>
    </tr>

    {% for lineItem in order.lineItems %}
    <tr>
        <td style="border-bottom:1px solid #cccccc;">{{ loop.index }} </td>
        <td style="border-bottom:1px solid #cccccc;">
          {{ lineItem.label|u.wordwrap(80) }}<br>
            {% if lineItem.payload.options is defined and lineItem.payload.options|length >= 1 %}
                {% for option in lineItem.payload.options %}



                    {{ option.group }}: {{ option.option }}
                    {% if lineItem.payload.options|last != option %}
                        {{ " | " }}
                    {% endif %}
                {% endfor %}
                <br/>
            {% endif %}
            {% if lineItem.payload.type is defined %}
    {% if lineItem.payload.type == "textfield" %}
        {{ lineItem.payload.value }}
        <br/>
    {% elseif lineItem.payload.type == "textarea" %}
        {{ lineItem.payload.value }}
        <br/>
    {% elseif lineItem.payload.type == "numberfield" %}
        {{ lineItem.payload.value }}
        <br/>
    {% elseif lineItem.payload.type == "datetime" %}
        {{ lineItem.payload.value|date("Y.m.d") }}
        <br/>
    {% elseif lineItem.payload.type == "timestamp" %}
        {{ lineItem.payload.value|date("H:i:s") }}
        <br/>
    {% elseif lineItem.payload.type == "htmleditor" %}
        {{ lineItem.payload.value }}
        <br/>
    {% elseif lineItem.payload.type == "imageupload" %}
            {% for media in lineItem.payload.media %}
                {{ media.filename }} <br/>
            {% endfor %}
        <br/>
    {% elseif lineItem.payload.type == "fileupload" %}
            {% for media in lineItem.payload.media %}
                {{ media.filename }} <br/>
            {% endfor %}
        <br/>
    {% endif %}
{% endif %}
          {% if lineItem.payload.productNumber is defined %}Artikel-Nr: {{ lineItem.payload.productNumber|slice(0,9) }}{% endif %}
        </td>
        <td style="border-bottom:1px solid #cccccc;">{{ lineItem.quantity }}</td>
        <td style="border-bottom:1px solid #cccccc;">{{ lineItem.unitPrice|currency(currencyIsoCode) }}</td>
        <td style="border-bottom:1px solid #cccccc;">{{ lineItem.totalPrice|currency(currencyIsoCode) }}</td>
    </tr>
    {% endfor %}
</table>

{% set delivery = order.deliveries.first %}
<p>
    <br>
    <br>
    Shipping costs: {{order.deliveries.first.shippingCosts.totalPrice|currency(currencyIsoCode) }}<br>
    Total costs net: {{ order.amountNet|currency(currencyIsoCode) }}<br>
        {% for calculatedTax in order.price.calculatedTaxes %}
            {% if order.taxStatus is same as('net') %}zzgl.{% else %}inkl.{% endif %} {{ calculatedTax.taxRate }}% MwSt. {{ calculatedTax.tax|currency(currencyIsoCode) }}<br>
        {% endfor %}
    <strong>Total costs gross: {{ order.amountTotal|currency(currencyIsoCode) }}</strong><br>
    <br>

    <strong>Chosen shipping method:</strong> {{ delivery.shippingMethod.name }}<br>
    {{ delivery.shippingMethod.description }}<br>
    <br>

    {% set billingAddress = order.addresses.get(order.billingAddressId) %}
    <strong>Billing address:</strong><br>
    {{ billingAddress.company }}<br>
    {{ billingAddress.firstName }} {{ billingAddress.lastName }}<br>
    {{ billingAddress.street }} <br>
    {{ billingAddress.zipcode }} {{ billingAddress.city }}<br>
    {{ billingAddress.country.name }}<br>
    <br>

    <strong>Shipping address:</strong><br>
    {{ delivery.shippingOrderAddress.company }}<br>
    {{ delivery.shippingOrderAddress.firstName }} {{ delivery.shippingOrderAddress.lastName }}<br>
    {{ delivery.shippingOrderAddress.street }} <br>
    {{ delivery.shippingOrderAddress.zipcode}} {{ delivery.shippingOrderAddress.city }}<br>
    {{ delivery.shippingOrderAddress.country.name }}<br>
    <br>
    {% if billingAddress.vatId %}
        Your VAT ID: {{ billingAddress.vatId }}
        If the check is successful and if you are ordering from an EU country
        you will receive your goods exempt from VAT. <br>



    {% endif %}
    <br/>
    You can also check the current status of your order at any time on our website in the "My account" - "My orders" section: {{ rawUrl('frontend.account.order.single.page', { 'deepLinkCode': order.deepLinkCode}, salesChannel.domains|first.url) }}
    </br>
    If you have any questions, please do not hesitate to contact us.
</p>
<br>
</div>

Example in the HTML e-mail

In an example where a text field and a date field have been filled in, the order confirmation with the code
inserted above looks like this:

DHL Shipping
With the extension you have the possibility to process orders directly from the administration via DHL
shipping. Offer your customers a DHL location search and easily create DHL labels with Shopware.

Installation

You can download DHL Shipping for free from the Store and install it in the Administration
(Settings > My Extensions).

General configuration

Under Extensions > My Extensions > DHL Shipping you can access the general configuration (1) of
the extension.

Map configuration

https://store.shopware.com/en/swagd99160772552f/dhl-shipping.html


Sales channel (1): First define for which sales channel you want to store the settings.
Google Maps API Key (2): Enter the Google Maps API Key here. This is necessary for the display of the
packing stations in the storefront to work.
You can find out how to get a Google Maps API Key here.
Country code (3): Enter the ISO code for the country here.

Default values for package dimensions

To be able to create a DHL label, the width, height, depth and weight of the parcel are required. The default
values stored here are automatically transferred to the order in the label generation area. No values are
stored in the standard of the app, with the exception of weight = 0.1 kg. Since each package can have
different dimensions, you can of course also store individual values per package. You can find more about
this in the last section DHL Label Generation.

Depth (4): Enter the default value for the depth of the package in centimeters.
Weight (5): Enter the default value for the weight of the package in kilograms.
Width (6): Enter the default value for the width of the package in centimeters.
Height (7): Enter the default value for the height of the package in centimeters.

Settings

https://developers.google.com/maps/documentation/javascript/get-api-key#create-api-keys
https://docs.shopware.com/en/shopware-6-en/extensions/dhl-shipping#dhl-label-generation


After you have installed and activated the extension, the extension gets its own menu item "DHL
Shipping - DHL Labels" in the administration under settings. In the overview you will first see all shipping
labels.

Generated labels

If you have not yet created a label, you can jump directly to the order via Show orders and create a label
there. How to create a label is explained in the section DHL Label Generating below.

If you have already created  labels, you can view the shipping labels for the orders here (1). You can also
edit the shipment details again, print the shipping label or cancel it completely (2).
You can transfer the order data to DHL via the End of the day process (3).

Shipping methods

https://docs.shopware.com/en/shopware-6-en/extensions/dhl-shipping#dhl-label-generation


Under shipping methods you can link your shipping methods to a DHL product. To do this, click on the
'Edit' icon (1) for the corresponding shipping method.

Mapping of the shipping method

DHL product (1): Select here which DHL product should be used. In the dropdown you can choose
between DHL Paket, DHL Paket International, DHL Warenpost and DHL Warenpost International.
Participation number (2): Enter the last two digits of your DHL invoice number. Normally this is "01".
Personal handover (3): Activate this option if you want to offer a personal delivery.
Retail Outlet Routing(4): Activate this option if you want to offer a routing.
The service is described here.
Ident-Check (5): Activate this option if you want to offer an ident-check.
The service is described here.
No delivery in the neighborhood (6): Activate this option if you want to prevent delivery in the
neighborhood. The service is described here.
Cash on delivery (7): Check this option if you want to offer cash on delivery.
Visual age check (8): Choose from the options None (no check), A16 (from 16 years) and A18 (from 18
years).
Transport insurance (9): Activate this option if you want to offer transport insurance.

https://www.dhl.de/en/geschaeftskunden/paket/leistungen-und-services/services/service-loesungen/filial-routing.html
https://www.dhl.de/en/geschaeftskunden/paket/leistungen-und-services/services/service-loesungen/ident-check.html
https://www.dhl.de/en/geschaeftskunden/paket/leistungen-und-services/services/service-loesungen/keine-nachbarschaftszustellung.html


The service is described here.
Bulky goods (10): Activate the option if you want to offer the bulk service.

Account

Manage DHL account (1): This takes you to the DHL business customer portal page.
Connect DHL (2): Here you can connect an existing DHL account.
Status (3): The display shows you whether a connection exists or not.

Connect DHL

DHL Username (1): Enter the username of your DHL account here.
DHL password (2): Enter the password of your DHL account here.
EKP number (3): Enter the EKP number here, which corresponds to the invoice number. You will also find
it in your DHL business customer account.
Become a member (4): Click here and you will be redirected to the page Become a DHL business

https://www.dhl.de/en/privatkunden/information/service-transportversicherung.html


customer.

Company (1): Enter the company name here.
Name (2): Enter the full name here.
Street (3): Enter the street name here.
Postal code (4): Enter the postal code here.
City (5): Enter the city that matches the postal code.
Country (6): Select the corresponding country here.

DHL location in the storefront

As soon as you have entered all basic settings and the connection with the DHL account was successful,
your customers can use the DHL location search in the storefront.



To select a DHL location, the customer must enter a different delivery address (1). As soon as a check
mark is set there, the DHL location option appears (2). If this option is also activated, the button Find DHL
location (3) appears in the address entry.

Example in the storefront

DHL Label Generation

To generate labels for a placed order, call up the order details in the administration.



In the order details you will also find the DHL label Generation in the additional fields section. Enter the
data for the package (width, height, depth and weight). You can only enter data there if you are in edit
mode. Afterwards click on Save.

After setting the label settings you can start the process Generating DHL Label (1).

Troubleshooting
Error message: "Could not sign payload with store secret for app:
"SwagDhlApp"".

This error can occur if you have downloaded the DHL app from a domain that is not licensed with
Shopware. If you get this error message, first check if the extension is also associated with your license
domain.



Label creation failed

If there is an error while creating the label in the order details, check the following:
Check under Settings > DHL Shipping - DHL Labels > Shipping types the participation number (1)
. This field is mandatory and necessary for the creation of parcel labels. Enter the last two digits of your
DHL invoice number in this field. In most cases this is the number "01".

Dynamic Access
The Dynamic Access extension is available as of the Shopware Evolve plan.

Since Shopware version 6.4.6.0 you can use the following feature. In cooperation with the Rule Builder, the
dynamic Access extension offers you the option of hiding certain contents of your shop depending on the
rules. For example, you can display specific categories or products only for selected customer groups.

Installation

If at least the Shopware Evolve plan is stored for the store domain in the Shopware account, you can
download and install the extension under Extensions > My Extensions.
It is important that you are logged in with your account in the Shopware Account tab.
After the extension has been installed, you can activate it using the button on the left side.



The installed extension does not have it's own menu item in the administration but is embedded in the
respective configurations for which you want to create rules. Currently this is the case in the categories and
products.

Categories

With the extension enabled, Dynamic Access is available to you under Catalogues > Categories in each
category. You can find it in the General tab in the General section.

In the Rules drop down menu you can select one or more rules from the Rule Builder. The category will only
be displayed to the visitor in the frontend if all the rules you have defined here apply. If no rule is selected
here, the category is always visible. How to create a new rule, you can read here.

In order to hide a category (using the dynamic access rule in the category), it is not sufficient to only store
the rule for the category. This must also be done for the products it contains, otherwise the products can
be found using the search and you end up in the hidden category.

Be careful not to select rules that are mutually exclusive, or the category may never appear.

Products

With the extension enabled, Dynamic Access is available to you under Catalogues > Products in each
product. You can find it in the General tab in the Visibility & structure section.

https://docs.shopware.com/en/shopware-6-en/settings/rules#create-rule


In the Rules dropdown menu you can select one or more rules from the Rule Builder or you can create a
new rule. The product will only be displayed to the visitor in the frontend if all the rules you have defined
here apply. If no rule is selected here, the product is always visible. How to create a new rule, you can read
here.

Be careful not to select rules that are mutually exclusive, or the product may never appear.

If a customer has a product in the shopping basket that is subsequently hidden by a rule (e.g. a shopping
basket rule that takes effect from a certain shopping basket value), the checkout process is blocked until
this product has been removed from the shopping basket.

Variants

You can also set the visibility by rules for each variant individually. To do this, open the variant
configuration of the respective product variant and navigate to the visibility & structure section.

The purple chain icon next to the rules item indicates that this setting is inherited from the main product.
To make an individual setting here, you can click on the chain symbol to cancel the inheritance. Now you
can select rules of the Rule Builder as usual from the main product, which then only count for this variant.

https://docs.shopware.com/en/shopware-6-en/settings/rules#create-rule


Variants are not hidden if they are not available, but they can no longer be selected on the product detail
page. Only when all variants of a product are no longer available due to rules, the complete product is
hidden.

Assigning multiple products

Using the Import/Export module, multiple products can be assigned to a Dynamic Access Rule at the
same time.
To do this, go to Settings > Import/Export > Profiles tab. There you can duplicate the default product
profile (1).

When you open the copy, you can add a new mapping (2) in the mappings tab (1) and assign the
Database entry "swagDynamicAccessRules" (3).

Then start the Export with the newly created profile, as described here in our documentation.

Now you can add the Rule ID to the column "dynamic_access" (1) in the CSV file.

https://docs.shopware.com/en/shopware-en/settings/importexport
https://docs.shopware.com/en/shopware-en/settings/importexport#export


Afterwards, the customized CSV file (1) is imported again via the newly created product profile (2). You
can find more information about the Import here.

After successful import, the Dynamic Access Rule was assigned to the products as previously edited in the
CSV file. 

 

Digital Sales Rooms

Digital Sales Rooms is available to you as an extension of the Shopware Beyond plan.

Digital Sales Rooms give you the opportunity to present a shopping event designed by you to the selected
customers.
It doesn't matter whether you want to interact with the customer in real-time or the customer navigates
independently and at any time through the shopping event. Both is possible without any problems.

https://docs.shopware.com/en/shopware-en/settings/importexport#import


You find the Digital Sales Rooms module in the Administration within Marketing > Digital Sales Rooms.

Configuration

To be able to use the Digital Sales Rooms, you need a daily.co account (API key) and a set-up Mercure
service. These two services are set up by your developer/administrator with the help of our developer
documentation.

You can access the configuration settings in 2 ways. The easiest way is via the menu Marketing > Digital
Sales Rooms > Configuration(1).

A second way is to go to Extensions > My Extensions > Digital Sales Rooms you will find some basic
configuration options.

https://developer.shopware.com/docs/products/digital-sales-rooms/local-installation/
https://developer.shopware.com/docs/products/digital-sales-rooms/local-installation/


The following window opens.

(1) Sales channel: Here you can set the settings for "All sales channels" or dedicated to a specific one. If
you have only one sales channel, the setting for "All sales channels" is sufficient. Of course, you can also
use the inheritance to make the settings for specific sales channels, which may differ from the others.
(2) API Base Url: This url is provided by an external video service provider.
(3) API Key: Here you can find the corresponding API Key for the url.

In this area, you add the layouts you have defined. You can add these in the Experience worlds area and
set them accordingly here.
These layouts can then be used as standard for presentations.

(1) Product detail page: Here you assign the product detail page that you can show to your customers.

(2) Quick view: Under Quick view, you can determine which layout your customer sees when they click on
a product. This layout will make your products stand out better.



(3) Product list page: You can assign a product list page via this drop-down menu.

(4) Finished presentation page: This layout is the most frequently seen of all the other four, as this
layout will be seen every time the presentation is called up once you have finished your presentation. If
chosen correctly, it will allow you to recall the impressions of the live presentation and thus maintain the
enthusiasm for your products.

Guide
 

This feature enables guides to perform actions for the customer. This can be, for example, adding items to
the shopping cart or liking products. The customer must explicitly agree to this before the guided
presentation starts. In addition, you as a guide always have the option to request this authorization during
the presentation.

Appointments

(1) Specify here after how many hours the appointment will end if there is no more interaction.
(2) Select the domain for Digital Sales Rooms here. You can find more details about this in the developer
documentation.

Presentations
Overview

https://developer.shopware.com/docs/products/guided-shopping/installation.html
https://developer.shopware.com/docs/products/guided-shopping/installation.html


New presentation

First of all, you should enter a name and then save the presentation to get further editing options.
Once you have saved the presentation, you can access the editing module. This is basically divided into
three areas.



(1) Information: Here you can see the name of the presentation and the status (active/inactive).
(2) Layouts: In this area, you configure how the presentation should be displayed. You will find out exactly
how to do this in the next section.
(3) Appointments: After you have created a presentation, you will get the settings for the event here.
You will also find out which settings these are below.

Layouts

(1) Create a new layout: This button takes you directly to the designer of the Shopping Experiences.
(2) Insert existing layout: Here you can assign layouts that you have already created. You can also
select multiple layouts.
(3) Preview presentation: This shows you a preview in the storefront as soon as a layout has been
added.

Layouts that are added in the "layouts" area are always standard templates. They can be used for multiple
presentations. You can use special presentation layouts and regular layouts as well. If you open the layout
by clicking on the name, you will be taken directly to the designer of the Shopping Experiences. You always
change the standard template here. To adapt layouts individually for a presentation, use the function
"Overwrite content". You can learn more about this in the following paragraph.

It is not possible to start the presentation here, as this function is only there to provide you with a quick
and easy way to adjust your configuration.

As you can see above, three different layout types were used for the presentation.
(1) Landing page: An element of the landing page type does not contain any products, which is why you
will not see any product options here.
(2) Product page: The "Add products" button opens a dropdown from which you can select products
quickly and easily.
(3) Category page: By clicking on the button "Add products" a new pop-up window appears. There you
can add the appropriate products using a manual selection or a dynamic product group.
(4) Overwrite content: This button takes you to the Layout tab. There you can quickly make changes for

https://docs.shopware.com/en/shopware-6-en/content/ShoppingExperiences


the respective layout, which will then be saved for your presentation. In the Layout tab paragraph, you will
learn which adjustments you can make.

Layout tab

As mentioned in the previous paragraph, you can use the Layout tab to quickly make changes to the layout
of the respective presentation. Here you only change the layout for the selected presentation and not the
default template.

(1) Layout: The layout tab is displayed as soon as you open a presentation.
(2) Select Layout: Here you can select the layout you want to overwrite with changes.
(3) Content: In this tab you can set the type of the "new" layout. You have the choice between Standard,
Large Image and Minimal Content.
(4) Sorting: Specify here if you want the default product sort to be displayed or if you want to use your
own sort. If you select your own sorting, another dropdown will appear. There you can set the sorting you
want.
(5) Filter: You can choose here, by which properties the products can be filtered from the customer. If the
standard filters are not sufficient for you, you can also add further filterable properties here.
(6) Content: This field allows you to quickly add text to the layout.
(7) Settings: Define here how the text should be aligned. You can choose between vertical alignment,
top, middle and bottom.

All elements (Content, Listing, Product) are designed using the usual designer of the Shopping Experiences.
The difference after creating the layout is that each element has a different type, which provides different
options.

Designing the layout with the Shopping Experiences



There are two ways to create a layout for Digital Sales Rooms. Either directly from a presentation or via the
Shopping Experiences. In both cases, you can design the layout with the Shopping Experiences Designer.

In the presentation
When you create a presentation and add a new layout, you will be taken directly to the Shopping
Experience Designer. There you can directly create a layout, which will be automatically added to the
presentation.

In the Shopping Experiences

Within Contents > Shopping Experience you can access your Shopping Experiences as usual. You will
now find presentations on the left side of the overview. There you can call up all layouts that can be used
for Digital Sales Rooms. You can filter by landing pages, category pages and product pages.

Create new layout

If you want to create a new presentation page, you also select one of the layout variants here.



You can use presentation layouts aswell as regular shopping experiences in the presentation.

Within the designer, you now have elements available that can be used exclusively for presentations. For
instance, you can insert the notes element into the layout and fill it with text. Notes are only displayed for
the guide and are not visible to the customer.

Creating an appointment in a presentation

As soon as you have created a presentation by saving it for the first time, it will automatically appear as a
non-guided appointment in the last menu item "Appointments". More information about appointments can
be found in the next section.

Appointments

You can create a new appointment when creating a presentation (Marketing > Digital Sales Rooms >
Presentations) or via the "Appointments" menu (Marketing > Digital Sales Rooms > Appointments).
We distinguish between two types of appointments. A non-guided appointment is generated by default
when creating a presentation, as already mentioned.
With a non-guided appointment, the customer can navigate through the presentation on their own. With a
guided appointment, the customer is guided through the presentation in real time.
In the following, we will show you where you can view all appointments at a glance and what the
differences are between creating a non-guided and guided appointment.

Overview



The overview shows you all guided and non-guided dates. You will find the most important information
there and you can also directly copy the participant and guide link.

The participant link is always given to the customer and the guided link is given to the corresponding guide
who leads and presents the customer through the appointment.

This allows the new invitation management, which is available within the appointments and can also inform
about changes to the appointment.

Create Appointment

(1) Presentation: Select an existing presentation here. (Note: This option is not available if you create an
appointment via the Presentation menu).
(2) Guide / Sender: Here you can set which user should be assigned to the presentation.
(3) Mode: Select between a non-guided or guided presentation.
(4) Name: Enter a name for the event here.
(5) Participants / Receivers: At this point, you can either enter individual e-mail addresses or select



from the list of your existing shop customers.
(6) Date from/ Date to: Here you can individually define from when and for how long the presentation
should be accessible.
(7) Message: Enter a message here that will later be included in the e-mail. Below, you can see how your
email will look like later.
(8) Domain: Select the domain here. Individual link: Here you can enter an individual suffix & overwrite
the automatically generated participant & guide links. Participans / Guide Link: This is automatically
generated & can be copied directly if needed.

Your domain determines the language of the presentation. Use the domains you have previously stored
and their assigned language as a guide.

(9) Audio and Video availability: Here you can set whether the video function of the customers is
activated at the beginning of an appointment. (Note: This option is omitted for a non-guided mode).

Invitation management

The invitation e-mail can then look like the following at the recipient's, depending on the note stored, and is
created within the respective appointment. The template for this e-mail can be changed via the e-mail
templates.

The status (Yes / No / Maybe) that can be assigned by the recipient can be viewed later in the appointment
in the Admin.

https://docs.shopware.com/en/shopware-6-en/settings/email-templates
https://docs.shopware.com/en/shopware-6-en/settings/email-templates


Under the item Already Invited, the respective status is displayed if this has been returned by the
recipient via the invitation email.

If changes are made to an appointment, for example, additional participants are added, then when the
appointment is saved or sent again, a request appears asking whether all or only the new participants
should be informed about the changes.

This also makes it possible to send e-mails about changes.

 

Guide view

To start as a guide you can use the link from the invitation mail or from the appointment.

A login is opened.

https://docs.shopware.com/en/shopware-6-en/extensions/digital-sales-rooms?preview=4fc9125596f483b6ffd92677cd31b920cd36352a0e874eb6b750afa0761b7def#create-appointment


After you are logged in, you are presented with the guide view.

On the right side, you find the presentation tools (1). The guide can start the presentation (2). Also,
you can add additional slides with product listings (3) that are not in the preparation.

The point saved products (4) can be used to add products into the presentation on the fly if an attendee
asks for it.

If the presentation is started, the guide is presented with the following page in which he can use the menu
at the bottom to manage the presentation.

To start click on the link from the invitation Email or use the button Guide in the Appointments view.

Presentation

Video & Audio



After you logged in, a pop-up appears to set up your audio and video settings. 

Start presentation

You can start the presentation here.

All participants with an invitation link will only land in a waiting screen, until the presentationis started.

As soon as a participant joins the started presentation, you will be notified of this at the bottom right of the
Guide view.

Many functions, such as the video & audio settings, are only visible and possible while the presentation is
running.

Tools in the guide view



Instant product listing

Instant product listing take you to the overview of product lists that you can compile before and during a
presentation.

Creating a instant product listing

With Filter

(1) Create instant product listing: Press this button to start filling the product list.
(2) Discard changes: All changes made will be discarded.
(3) Add Products: As soon as you press this button, the pop-up window opens with all the products that
you have previously assigned to the presentation.
(4) Search: Search for products from your list or from the range using the search function.
(5) Notes: Here you can see whether and how many notes were made in advance for this slide.
(6) Show: If you press this button, you can open your notes.
(7) Filters: Here you can filter the products displayed if, for example, the customer has specified
requirements in advance.
(8) Add all: With the Add all button you can add all products displayed in the current filter to the list, for
example if your customer wants to test all your products or those of a specific manufacturer.
(9) Remove all: The Remove all button removes all added products so that you can quickly clean up your
list.
(10) Remove from list: This button only removes the products affected by the filter. If, for example, the
customer sets a price limit or does not want anything from certain manufacturers, you can easily and
specifically clean up your listing.

Settings

Broadcast mode



Here you can turn the presentation from a meeting into a tour, just like during the appointment creation.
All the participants' cameras and microphones are switched off and cannot be switched on again until you
authorize it with the switch. During the tour, customers will be able to concentrate more on your products,
and you can present your product range smoothly.

Participants are allowed to share their screen

You can use the switch (1) to grant permission for participants to share their screen during the
presentation.

If, as a guide, you want to share your own screen, you need to click the share button (2). A pop-up window
(3) will then appear at the top of the window, where you can specify exactly which view you want to share.
You can choose between Tab, Window, and Entire Screen. Once you have selected the view to be shared,
click on Share (4) to finalize.

After you click on Share, you will see a notification (1) in the top left corner indicating that you are
currently sharing your screen. If you click on the Share button (2) again, you can either stop presenting
(3) or present something else (3). If you click on Share something else, you will again have the option
to select in the pop-up which tab or window you want to share. You can also stop sharing your own screen
or that of a participant by clicking the Stop Screen Sharing button (4).

Finish presentation



Once the presentation has ended, it cannot be started again without a new appointment.

Even after you end the presentation, your customers can still access the presentation via the link, continue
viewing it, edit their shopping cart and continue browsing the slides. This is possible as often as required
until the presentation ends. 

As soon as the date until which the presentation should finally run has passed, the invitation link leads to a
blank page. Therefore, think carefully in advance about how long your customers should have access to the
presentation.

Notes

When notes for the guide were added in the shopping expericence they will appear in the left bottom left
corner.These Notes can be used to give additional information to the guide.

If you open the Guide tools in the bottom left, you will find the notes in the bottom part of the tools page.
At first, the notes are hidden and can be shown with the button Show(1).



Navigation menu

Here you can switch between the individual pages of the presentation for you and your customers.
Customers can see in real time when you switch from one page to the next, and are thus led by the hand
according to your needs. This dynamic allows you to capture the attention of the participants and keep
them with you during a longer presentation.

Customers do not see the navigation bar in guided mode.

List of Attendees



In the list of attendees, all active and inactive users are listed. Next to the names of the attendees, you can
see the symbols of video and audio if available but deactivated by the attendee.

You can open the list by clicking on the attendee (1) button in the navigation bar and the list appears on
the righthand side of your screen. In the upper part of the list, there is a field to search (2) specific
attendees. You can also remove participants who can no longer join the presentation.

Recently viewed products

During the presentation, you can recognize an eye icon (1) in real-time next to the products that
customers are currently viewing. This helps you understand what your current target audience is interested
in. Additionally, you can view the history of all viewed products through the Recently Viewed button (2).



In the Recently viewed Products view, you can, as the moderator, see the history of the products you
have opened and even filter the view by individual participants.

In the details of each product, you can see who else is currently viewing that product.

 

Wishlist Overview

In the Wishlist view, you as the guide have the opportunity to view, which products your attendees put in
their Wishlist. You can open it with the wishlist (1) button. The list appears on the right side of your
screen. The initial view shows the accumulated wishlists of all attendees. With the dropdown Participant
(2) you can filter to a specific attendee. The search field (3) offers you a filter for a specific product.



With the Sort (4) Button you can sort the List of products by Qantity(default), Revenue, and Name.

If you cannot view a customer's wish list, it is possible that your customer has not authorized this. You can
request the necessary authorization from the customer from the list of participants.

Shopping cart overview

The guide has a connection to all shopping carts of the attendees. He can see, which products within the
presentation are added the most. Also, he can pick a cart from an attendee to view its contents.



To open the shopping cart view, click on the shopping cart (1) button.
It opens the list of products that are currently stored in the shopping carts of the attendees. You can see
the number of products, that are added to the cart, in every product line.

With the drop-down Participant (2) you can switch between the accumulated list of all attendees or a cart
of a specific attendee.

With the search field (3), you can search a specific product within the carts.

The Sort (4) Button is used to sort all products by quantity, revenue or name

Customer view
Unguided Session

Your participants assigned to the presentation will receive an email containing the link to the presentation
if they are already registered as existing customers. For new customers, you can send the link as a
newsletter, for example.



If the customer clicks on the link, they will be taken to a notification page if the time slot for the
presentation has not yet been reached.

Once the time slot for the presentation has been reached, the participant is taken directly to the
presentation.

Presentation sequence 
In the unguided presentation, the customer can click freely through the individual pages.

The participant can use the navigation (1) to jump directly to a specific page of the presentation, in this
case a landing page is displayed first.
Clicking on the arrows (2) takes the customer to the next or previous page.
By clicking the Recently viewed products button(3), the participant can access the history of the
products they have viewed.
By clicking on the Whishlist (4), the participant can access the list of products that they have entered as
favorites.
The shopping cart button (5) takes the participant to their shopping cart.

Navigation



Using the navigation, the participant can either jump directly to a specific page of the presentation or click
forwards or backwards through the presentation pages using the arrow keys.

Product view

If an attendee clicks on a product from the list, it is opened in fullscreen. This view can be used to add the
product to the shopping cart or the watchlist.

Attendee functions

These appear as a list on the right-hand side of the screen.

Last viewed products



The list of recently viewed products is created automatically as soon as the participant opens individual
products.

Wishlist

The participant can add products to the wishlist (3). To do this, the participant can click on the Add to
list (1) button in the product list or within the product. They can also remove the product by clicking on
the Remove (2) button in the product list or on the X (4) button in the wishlist. However, the whislist is
independent of the shopping cart and should not be confused with it.

Shopping cart

The shopping cart (1) button takes the participant to their shopping cart. This appears as a list on the
right-hand side of the screen.



To add a product to the shopping cart, the participant clicks on the Add to cart button (2) either in the
product list or within the product.
If a product is already in the shopping cart, the order quantity can be changed using the + and - buttons
(3).
Behind the button, there is a further button to add the corresponding product to the whishlist (4) or to
remove it.
The X (5) button can be used to remove a product from the shopping cart.

To order the products in the shopping cart, you can start the checkout by clicking the Checkout button
(6) at the bottom

Checkout

At the checkout of the store, the attendee can either log in with an existing customer account or create a
customer account.

With all the required data, the order can be created and is now managed like a regular order.

Share screen



Participants can share their screens, provided that the guide has enabled this feature (see the section
Participants are allowed to share their screen). To do this, participants must click the Share button (1),
then select the tab, window, or entire screen they want to share in the pop-up (2), and confirm by
clicking Share (3).

Guided Session

In guided mode, attendees are led through a presentation by the guide in a targeted and personalized
manner.

The links to the events can be found directly in the presentations or in the general event overview:

Marketing > Digital Sales Rooms > Presentation > "Presentation XY" > Appointments.

Marketing > Digital Sales Rooms > Appointments.

All participants invited by you will receive the link via an invitation email.

If the attendee uses the link from his e-mail, he will be taken to a landing page if the time slot specified in
the presentation has not yet been reached.

Once the time slot for the presentation has been reached, the participant is taken to a login page.



Via this login page, the attendee can now decide whether he wants to participate as a guest(1) or log in
with his existing customer account(2).

The guest session can follow the presentation and use all functions, but to order the shopping cart, if filled,
the participant must complete the checkout at the end of the presentation by registering a customer
account.

An attendee with an existing customer account can log in with their data, use the shopping cart, and simply
order it without entering any further data.

If an attendee without an existing customer account decides to create a customer account directly, the link
Create an account(3) is available.

Guest session

If the attendee decides on a guest session, the next step is to enter a name and the option to release the
shopping cart for the guide.



Attendees must also agree to daily.co's privacy policy to participate.

Should the participant nevertheless wish to register with an existing customer account, he/she can switch
to regular registration via the link at the bottom.

Login with existing account

If an existing customer logs in, an intermediate window first appears to allow the guide to access the
customer's shopping cart.



The existing customer joins the presentation by clicking on the Join button.

Attendance at the presentation

After the attendee has logged in, a configuration page appears for setting the audio and video connection.

The microphone, loudspeaker and camera can be selected and activated here.

You can also select a filter or virtual background for the camera image.

All registered participants are first taken to the waiting room if the guide has not yet started the
presentation.

When the guide starts the presentation, the attendees are taken to the following view. In contrast to the
unguided presentation, the attendee cannot move freely through the pages of the presentation but follows
the guide.



(1) Show video: The attendee can use this button to show and hide the camera image of the guide.

(2) Jump to guide: Takes the attendee to the part of the page that is currently being discussed by the
guide.

(3) Deactivate microphone: The attendee can use this button to deactivate and activate their
microphone.

(4) Deactivate camera: This button deactivates the transmission of the camera image. If the camera is
deactivated, it can be reactivated.

(5) Leave presentation: You can leave the presentation by using the hang-up button, and after you have
left, you can rejoin the presentation through a new button.

(6) Audio-video settings: This is where the attendee accesses the configuration of the camera and audio
connection. The participant can select the devices for video and sound transmission here. The participant
can also set up a blur mode for their camera image to protect their privacy, which blurs the background. 

(7) Subscriber list: Opens the list of active attendees.

(8) List of recently opened products: The attendees can access the history of their most recently
opened products here.

(9) Watch list: The attendee can access the wishlist with their products here.

(10) Shopping cart: Opens the attendee's shopping cart. The order can be completed via the shopping
cart.

Request for quotation

When you activate the Quote Management (2) from the B2B Components via the Edit button (1) in the
customer data (Customers > Overview), your customers can request quotations within presentations.

https://docs.shopware.com/en/shopware-6-en/commercial-features/b2b-components


Once the presentation has started and your customers are in it, the Request quote button (2) will
appear when they open the shopping cart (1). Using this button, they can send you a request for
quotation.

After clicking Request quote (2), a pop-up will appear where the customer can send you a message.



Once the request has been submitted, the customer has the option to go directly to the quotation requests
in the storefront via a button in the pop-up. When clicked, the Quotes menu item and the quotation
requests within it will be displayed in the customer's account.

In the admin area, you can view the quotation request under the menu Orders > Quotes once it has been
received.



There, you can either Send quote (1) or send message only (2). Further details about the quotation
function can be found in the article on B2B Components.

Appointment Booking

In the admin, under Marketing > Digital Sales Rooms > Configurations, you can enable the option
Allow participants to book a new appointments (1) to give your customers the possibility to send you
appointment requests for presentations. These are available to your customers in both the unguided and
guided modes. However, in guided mode, your customer can only select the appointment booking request
once the guide has finished the presentation appointment.

https://docs.shopware.com/en/shopware-6-en/commercial-features/b2b-components#quote-management


Your customers can send you these appointment requests in unguided mode when you have scheduled a
presentation and invited the customers. To schedule a new appointment, go to Admin > Marketing >
Digital Sales Rooms > Appointments and click Create Appointment. Afterwards, in addition to the
usual settings, which are explained in more detail in the Create Appointment section, you can enable the
following options under Advanced settings:

(1) Allow attendees to send emails from within presentations: Enabling this option allows your
customers to send requests via email directly from the presentation.
(2) Allow customers to request appointments: Once this switch is activated, your customers can
send appointment requests from the presentation. In the required field for this option, your booking
link (3) must be entered. Microsoft Bookings has been used as an example here, which manages
appointments via an Outlook calendar.



Once your customer is within the unguided presentation, they can submit a request by clicking on the
speech bubble icon (1) and then clicking on Book an appointment (2).

After clicking on Book an appointment (2), your customer will be redirected to the booking service you
have provided. In this example, to Microsoft Bookings.



Your customer can book an available appointment there, which is then confirmed to your customer by e-
mail:

Immersive Elements

Immersive Elements consists of five dynamic blocks and is designed to engage customers, strengthen
brand loyalty and increase conversion rates. The app is optimized for mobile, desktop and immersive



devices such as VR headsets, ensuring a seamless and truly memorable shopping experience across all
devices. The following five blocks are available in the first version of the app:   

Immersive Elements - Cylinder Gallery
Immersive Elements - Depth Gallery
Immersive Elements - 3D Model Journey
Immersive Elements - Slide Behind Gallery
Immersive Elements - VR Cinema 

You can find these blocks in the experience worlds in the blocks section under "Commerce".

About the extension

In collaboration with Instorier, the Norwegian experts in digital storytelling, we have developed an
innovative app that transforms your online store into an unforgettable and dynamic brand experience.

Immersive Elements launches with five powerful components designed to engage your customers, build
brand loyalty and increase conversions.

Fully optimized for mobile, desktop and spatial devices, the app delivers an immersive shopping
experience.

Immersive Elements integrates seamlessly into your Shopware infrastructure and is a highly cost-effective
alternative to using external resources.

Klarna Payments

Installation

The installation of Klarna Paymsnts is possible in several ways.
On the one hand, you can obtain and configure the extension directly during the installation of Shopware in
the initial setup wizard.
On the other hand, you can also license the Klarna Payments extension directly in the Shopware Store at 
store.shopware.com. You can then download and install the extension under Extensions > My
Extensions. 
It is important that you have previously logged in with your account in the Shopware Account tab. 
After the extension has been installed, you can activate it using the button to the left of the extension.

Klarna Payments

http://store.shopware.com/


With Klarna Payments you can give your customers an easy shopping experience. You are always paid in
full upfront, while your customers can decide when to pay.

Klarna offers you the following payment options:

Klarna Invoice - Let your customers receive the goods first and pay later by offering them an extra 14
days to complete their payment. Without fees.
Klarna instalment purchase - Give your customers the flexible option to buy now and spread the cost
over monthly payments.
Klarna instant bank transfer, direct debit and credit card - Direct payment offers your customers a
fast, secure and easy way to make direct and automatic payments.

Documentation Klarna Payments

Customer specific pricing

The customer specific pricing is available to you from the Shopware Beyond plan via the Shopware
Commercial extension.

The extension allows you to offer individually calculated prices to each customer. You can tailor list prices
as well as graduated prices or currency-dependent prices individually to the customer.
The prices can be easily integrated into Shopware via an interface from any system, for example an ERP
system. Thanks to the API, which is designed for speed, even large amounts of data are synchronized and
provided quickly.

We have documented a detailed description of the API for the customized prices here.

Requirements

To use the feature you need a Shopware Beyond Plan and the extension Shopware Commercial.

Installation

Creating, reading, changing and deleting custom prices is only possible via the API. For this reason there is
no extension in the store. In addition, there is no separate module in the administration, through which the
function is mapped. The prices are transferred seamlessly via the API.

Inheritances, such as with product variants, are not taken into account. To access the respective variant,
you need the corresponding ID of the variant.

Storefront

https://klarna.kellerkinder.de/sw6/en/index.html
https://shopware-docs.stoplight.io/docs/admin-api-reference/292aa491853da-bulk-edit-custom-prices
https://docs.shopware.com/en/shopware-6-en/features/shopware-beyond
https://docs.shopware.com/en/shopware-6-en/extensions/shopware-commercial


The individual prices are displayed in the storefront directly for the respective customer as soon as he logs
into the store (1). As soon as the customer logs out (2), the original price is displayed.

Paypal

PayPal Checkout is the all-in-one solution that allows you to offer powerful and flexible payment processing
features. With PayPal Checkout, you can submit your customers payments by invoice, credit card, direct
debit, and many other local payment methods in addition to the classic PayPal.

Installation

The installation of Shopware Markets is possible in several ways. On the one hand, you can obtain and
configure the extension directly during the installation of Shopware in the initial setup wizard. On the other
hand, you can also license the Shopware Markets extension directly in the Shopware Store at 
store.shopware.com. You can then download and install the extension under Extensions > My
Extensions. It is important that you have previously logged in with your account in the Shopware Account

http://store.shopware.com/


tab. After the extension has been installed, you can activate it using the button to the left of the extension.

Configuration Onboarding

The configuration for PayPal Checkout can be found via Settings > Payment methods.

Sandbox (1): This option can be enabled if you want to test the PayPal integration. In this case, no real
payments will be made. Please note that the sandbox environment has its own credentials. 
Connect PayPal account / Start PayPal Checkout onboarding (2): To complete the setup of PayPal
Checkout, onboarding must be carried out via this button. Onboarding is required to:

1. establish the connection to the merchant’s PayPal account (the merchant ID will be retrieved),
2. automatically generate the credentials (Client ID & Secret) [technical background: a REST app is

created for API calls to PayPal],
3. for payment methods such as advanced credit card or pay by invoice, which require approval, an

automatic security check will be performed.

Connect PayPal sandbox account / Start PayPal Checkout sandbox onboarding (3): With this
button, you can start the onboarding for your PayPal sandbox account via the PayPal website. The PayPal
API sandbox credentials will be configured automatically. 
Payment method name (4): PayPal Checkout provides many different payment types. The respective
payment type is defined under this item.
Payment method status (5): The payment method status indicates whether the payment method can
currently be used in your store or not. The status Onboarding needed and Authorized are possible.
Edit details (6): With this button, the PayPal payment method can be edited as any other payment
method can. The description and an availability rule can be set up here, for example. 
Activate/deactivate payment method (7): You can use this button to activate or deactivate the
respective payment method for your store. 



Paypal shipping tracking

With Paypal version 5.3.0 it is possible to transfer the shipping tracking ID of the shipping service provider
to Paypal. However, this function is only available after successful checkout onboarding.

After that, you can set a default shipping provider under Settings > Shipping methods. You can find a
list of possible shipping providers here.

In order to be able to transfer the tracking ID to PayPal, you have to manually enter the respective
shipment number in Shopware. Add the number in the respective customer order within the order details.
The added information will be automatically forwarded to PayPal after the entry.

General configuration

You can configure PayPal in the admin under Settings > Extensions by clicking on PayPal.

https://developer.paypal.com/docs/tracking/reference/carriers/


Sales channels

In this drop-down menu, you can select for which of your sales channels the settings should be made. You
can choose between All sales channels or individual sales channels. With the button Set PayPal as
default, you can activate PayPal in the selected sales channel and set it as the default payment method.

Configuration API settings

As an alternative to onboarding, you can also enter your PayPal API credentials directly, if available. 
Client ID (1): Here, you enter the PayPal REST ID. This is used by the extension to authenticate with the
PayPal API.
Client secret (2): Here, you enter the REST-API Client-Secret, which the extension also uses to
authenticate itself with the PayPal-API.
PayPal Merchant ID (3): This is where you enter your PayPal Merchant ID to authenticate the new PayPal
Checkout feature.
Test API credentials (4): With the help of this button, you can test the credentials you entered. The
result of the test will be displayed directly on the button itself.
Enable Sandbox (5): With this option, you can activate PayPal sandbox to test the integration.
Sandbox client ID (6): Here, you enter the PayPal Sandbox REST ID. This is used by the extension to
authenticate itself with the PayPal API.
Sandbox client secret (7): Here, you enter the Sandbox REST API client secret, which the extension also
uses to authenticate itself with the PayPal API.
Sandbox PayPal Merchant ID (8): This is where you enter your Sandbox PayPal Merchant ID to
authenticate the new PayPal Checkout feature.
Test Sandbox API credentials (9): With the help of this button, you can test the credentials you
entered. The result of the test is displayed directly on the button itself.



Behavior

Under behavior, you can make basic settings for the extension that are not only valid for the classic
PayPal but also for the Express Checkout.
Merchant location (1): Here, you can enter your merchant location.
Payment acquisition (2): This is where you define when the payment is collected - i.e., when it is closed.
Submit cart (3): Here, you can choose whether the customer's shopping cart, i.e., the exact positions of
the order, are allowed to be transferred to PayPal. If this option is deactivated, only the total amount is
transferred.
Your own brand name on PayPal page (4): Here, you can set your own brand name for the
advertisement on the PayPal payment page.
PayPal landing page (5): Here, you can choose whether the PayPal landing page should display the
registration form or the login screen.
Submit order number (6): Activate this option if you want to send the order number to PayPal after
completion.
Order number prefix (7): Here, you can determine which text is appended to the original order number,
e.g., myShopSW20001. This option is only available if you have activated the previous option, "Submit
order number to PayPal".
Order number suffix (8): Here, you can determine which one is attached to the order number,
SW20001meinShop.
Excluded products (9): Here, products can be excluded from being paid for via PayPal payment
methods. 
Excluded dynamic product groups (10): Here, entire dynamic product groups can be excluded from
being paid for via PayPal payment methods. 



Vaulting (regular payments)

Vaulting is available from PayPal version 8.0.0 and Shopware version 6.5.

In order for your customers to be able to use recurring payments, e.g. for a subscription, vaulting must be
activated for PayPal.

To activate Vaulting for your store, click on the Activate Vaulting (1).

You will now be taken to the login for your PayPal merchant account.

https://docs.shopware.com/en/shopware-6-en/settings/shop/subscriptions


 There you log in with your access data and the activation is carried out.

If you now switch back to the store, you will see the buttons to activate the function.



With the Enable vaulting for PayPal payments button (1), you generally activate the function.

With the Enable vaulting for credit and debit card payments button (2), you can also activate
whether your customers can charge their credit or debit card via PayPal.

However, this requires that you have activated payments via credit or debit cards.

Credit- or debit card

The PayPal Checkout plugin offers two different types of credit and debit card payments. If the activation
for advanced credit and debit card payments is successful during onboarding (this depends on the country
and the merchant account), the "unbranded" payment option—i.e., without reference to PayPal as the
payment provider—will be available. If approval cannot be granted, the payment option will be provided as
"branded," meaning the form for entering card information will include a reference to PayPal as the
provider.

PayPal uses the credit or debit card to check whether strong customer authentication via 3D Secure is
required. If the option Block payments from non-3DS countries is activated, the corresponding card cannot
be used for payment if a 3DS check is not possible.
3D Secure is a protocol to ensure safer payment with credit- and debit cards. 

Pay upon invoice

With the Pay upon invoice, your customers can place the order as a purchase on account. PayPal settles
the invoice amount to you as the store operator, and the customer must settle the invoice as a transfer to
PayPal / Ratepay.

Configuration

This field can be used to implement additional information in customer e-mails for the payment method
purchase on account, for example, notes on payment.



Invoice document 

If your customers place their orders with PayPal invoice purchase, the invoice will be paid by PayPal to you
as the shop operator. This means that your customers have to transfer the invoice amount of their order
directly to PayPal. For this purpose, your customers will automatically be shown the correct bank details
after placing their order.

This payment information is also automatically displayed in the invoice if you create it under "Receipts" for
this order.



Storefront presentation

If you have activated the option double opt-in for guest orders under Settings > Shop > Log-In &
sign-up, no payment buttons will be displayed in the storefront.

Express Checkout Shortcut

The PayPal extension also offers the possibility of express checkout. With this option, your customer does
not have to register in the shop for his order. The order will be processed solely through his PayPal account.

Configuration

'Direct to PayPal' on detail page (1): Here, you can define whether the PayPal Express Button is shown
on the item detail page.
'Direct to PayPal' in the shopping cart (2): Here, you can define if the PayPal Express Button should be
shown in the shopping cart.
'Direct to PayPal' in the Off-Canvas shopping cart (3): If you activate this option, the Express
Checkout Button will be shown in the Off-Canvas/Modal shopping cart.
'Direct to PayPal' on the login page (4): Here, you can determine whether the PayPal Express
Checkout Button is offered on the login page.
'Direct to PayPal' on listing pages (5): If you activate this option, the Express Checkout Button will be
displayed on listing pages.
Button color (6): This option offers you some colors in which the PayPal Express Button can be displayed.
Gold, blue, silver, and black are offered.
Button shape (7): Here, you define the shape of the PayPal Express Button. You can choose between
round and square.
Button language (8): In this field, you can enter different shop languages for the Express Checkout
button. If the field is empty, the sales channel language will be used.



It is important that you enter the so-called "locale code" here, such as en_GB. A list of available language
codes can be found on the PayPal site. You can also open the page by clicking on the link "here".
Display 'Pay Later' button next to the 'PayPal Checkout' button (9): Here, you can activate the
option, that the 'Pay Later' button will be displayed next to and with the same design as the 'PayPal
Checkout' button. 

'Pay Later' banner-

The PayPal extension enables you to display a banner for the installment payment and Pay Later on the
item detail page, the (off-canvas) shopping cart, and when changing the payment method in the order
process. This banner will be displayed on the items that match the criteria for the installment payment. For
your customers to use the new installment payment in your shop, they must select the payment method
PayPal in the checkout and log in with their PayPal account. Your customers can then check whether the
payment method Installment Payment is available.

Requirements

PayPal Pay Later is applicable for a shopping cart of 1 Euro or more. The maximum shopping cart
value is 1,000 Euro. 
PayPal installment payment is applicable for a shopping cart of 5 Euro or more. The maximum
shopping cart value is 5,000 Euro.

Further information about PayPal installment payments can be found here.

Configuration

https://developer.paypal.com/docs/api/reference/locale-codes/
https://www.paypal.com/de/webapps/mpp/paypal-instalments


'Pay Later' banner on detail page (1): If this option is active, the 'Pay Later' banner will be shown on
each product detail page.
'Pay Later' banner on cart (2): If this option is active, the 'Pay Later' banner will be shown on the cart.
'Pay Later' banner on off-canvas cart (3): If this option is active, the 'Pay Later' banner will be shown
on the off-canvas cart.
'Pay Later' banner on login page (4): If this option is active, the 'Pay Later' banner will be shown on the
login and register page.
'Pay Later' banner on footer (5): If this option is active, the 'Pay Later' banner will be shown on the
footer.

Storefront view

Article detail page:

Offcanvas shopping chart:



Shopping cart:

Footer: 

Smart Payment Buttons

If you have selected "Other merchant location" under Behavior for the merchant location, the Smart
Payment buttons will be displayed in the checkout in your store. For the configuration of these smart
payment buttons, a new configuration option will be displayed as soon as you have changed the merchant
location.



Configuration

Enable the alternative payment methods for the Smart Payment Buttons (1): Enable the
alternative payment methods for the Smart Payment Buttons.
Display Pay Later as a separate button (2): If the button is also, a "PayPal Pay Later" button is
inserted, which leads the customer directly to the PayPal option to pay the amount after 30 days.  
Button color (3): This option offers you some colors where the PayPal Express button can be displayed.
Gold, blue, silver, and black are offered.
Button shape (4): Here, you can define the shape of the PayPal Express button. You can choose between
round and square.
Button language (5): In this field, you can enter different store languages for the Express Checkout
button. If the field is empty, the sales channel language will be used. It is important that you enter the so-
called "Locale Code" here, such as en_GB. You can find a list of available language codes on the PayPal
page. You can also open the page by clicking on the link "here".

Storefront view

The smart payment buttons are displayed instead of the normal checkout button:

https://developer.paypal.com/api/rest/reference/locale-codes/


Paypal Refund

If an order has already been paid for, and you would like to cancel or refund this payment, this is possible
via the actual order. For this purpose, you will find the Paypal tab with the item Create a new refund 
within the order.

The button create a new refund opens a new window in which optional information such as an invoice
number or a reason for payment can be entered.



Via Execute, the amount is refunded and the payment status of the order is automatically set to
Refunded.

Advanced
Webhook

The webhook is used to facilitate the exchange between Shopware and PayPal. If the webhook is not set
up, orders and information cannot be exchanged. You can re-register the webhook by clicking the "Update"
button.

Pay Later - Cross-Border Notifications

The "Pay Later - Cross-Border Notifications" feature from PayPal allows customers to make purchases
immediately and pay later, while ensuring that all notifications and communication processes are handled
internationally and user-friendly. This facilitates cross-border transactions and ensures that customers in
different countries are informed and reminded about their payments.

To use this feature, please contact your PayPal representative, as your merchant account needs to be
enabled for this feature.

PayPal disputes

If customers can pay you with PayPal, it can, of course, happen that disputes are opened on PayPal, to
which you have to react. These can be, for example, incomplete or defective deliveries.



As of version 2.1.1, the PayPal extension offers you the ability to display all open PayPal disputes in your
Shopware Admin.

Overview

You can find the open cases in your Shopware Admin under Customers > PayPal Disputes.

Overview (1): In the overview, you will find all open PayPal disputes and the most important information.
On the one hand, the case ID, which you can use to open the case details. Furthermore, the last update,
the due date of the next reply, the current status, the current stage of the conflict, and the amount at stake
in the conflict case.
PayPal resolution center (2): This link, next to each conflict, will take you directly to the PayPal
resolution center for the case in question.
Refresh (3): With this button, you can refresh the view of the conflicts. 
Filter (4): The filter allows you to filter the displayed disputes according to the dispute status and the
sales channel.

In order to filter by sales channel, it is necessary to use a separate API for each sales channel.

Case details

You can access the case details through the case ID in the overview. Here you have all the details of the
case listed once again.

http:// /en/shopware-6-en/extensions/paypal#sales-channels


Details (1): Here, you will find all the details of the open case.
Links (2): The links at the top of the page will take you directly to the PayPal resolution center for the case
in question, where you can handle the case. On the other hand, you will find a link to the affected order.
(This is currently only displayed for orders created using PayPal Express).
Raw data (3): In the raw data field, you will find a JSON string that contains all the information that
Shopware has received from PayPal concerning the case.

Failed payments

Failed payments can happen for a variety of reasons. Possible reasons and further information can be
found here.

Update

To perform an update for the extension, you go to Extensions > My Extensions. In the list, find the
PayPal extension, and in the next step, you can click on the Update button. The update will then run in the
background, and the page will automatically reload.

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/ordering-with-paypal


Alternatively, you can initiate the update via the CLI by entering the following command in the console:

php bin/console plugin:update SwagPayPal

Troubleshooting

If you performed an update directly via SFTP/FTP, it may cause issues in the admin panel. Shopware 6
might not function correctly due to file movements. Additionally, the extension cannot be updated through
the admin panel in this case. If this occurs, the following steps can help rectify the issue. These steps
should be followed sequentially:

Reset OPCache (restart php-fpm or the entire server)
Clear the shop cache (execute php bin/console cache:clear or delete the var/cache folder)
Update the plugin (run php bin/console plugin:update SwagPayPal or update through the
administration)

Shopware Legal Services
With the Shopware Legal Services extension you have the possibility to generate customized legal texts for
your store. We work together with our partner Trusted Shops to always provide you with up-to-date, legally
compliant and localized texts. Besides automatic updates, Trusted Shops also assumes liability for all
generated legal texts.

Installation



You can easily install the extension via the store in the administration. Once the app is installed, you can
find it under My Extensions.

You can find the extension in your administration under Content > Shopware Legal Services - Legal
Texts.

Overview

When you open the module, you will first get to an overview where all your sales channels are listed.
Further up you will also find links to the Shopware documentation and to the support of Trusted
Shops (1) to get more information or help.

Sales Channel (2): In this column all sales channels are displayed.
Country of residence (3): For your legal texts, the country of residence is of course decisive. Please note
that you cannot change the country of residence after you have created it for the first time.
Languages (4): Here you can see the languages of the legal texts.
License status (5): Here you can see whether the respective sales channel is currently licensed or not.
Document status (6): Shows whether legal texts have been created and whether they are current or
need to be updated.

https://docs.shopware.com/en/shopware-6-en/extensions/myextensions


Configuration
Add sales channel

If you want to add legal texts for one of your sales channels, you have to define a country of residence in
the first step (1).

Note: After saving, the country cannot be changed anymore.

In the next step you can view the details (2) to configure the legal texts. If the field is not clickable, make
sure that a domain is assigned to the sales channel.

Supported countries and languages:

Germany (German, English)
Austria (English, German)
Switzerland (German)
Netherlands (Dutch, German)
Belgium (German, French)



In the next step you will get to the subscription menu. There you will automatically see the languages that
are available for your country of residence.
Below you will find information about the duration, automatic renewal and costs.
Select the desired language and click on Book with costs (1). After that the subscription is licensed.

Add documents



As soon as the subscription of the sales channel is licensed, you can create documents for the legal texts.
Select the previously licensed language (1).
Then you can generate a new document (2).

Before each individual configuration it is necessary to enter some basic information.

After you have made your selection, you can click on Continue to questionaire (1).
In the question catalog you can now enter all information for an individual legal text.



To save all the information you have entered, click on Finish (1).

Note: The questions are displayed in german if you have set the country of residence to Austria, Germany,
Netherland or Switzerland. If you have set Belgium, the questions are french. The final document with the
answers is assigned to the subscription language.

Verify data



In the last step you get a summary of all answers, so that you can check everything again.
You can also download all answers to the questions as a protocol in PDF format (1).
When you have checked all the information, click on Confirm (2) so that the document is generated.

In the overview you will now find the generated legal text as well as all other documents for this language.
Note that the document is not yet visible in the storefront.

Transfer document to layout

To display the text in the storefront, click Show Details (1).
In the menu you have basically two options to display the legal text in the storefront:



Copy text (1): In the editor window you can simply copy the text and paste it into a layout of your
shopping experience.
Transfer (2): You can transfer the right text into an existing layout. First select the language, then the
layout and the slot. Complete the assignment by clicking Transfer now. To check the successful transfer,
you can navigate to your Shopping Experiences (Content > Shopping Experiences) and select the
appropriate layout, in this case Imprint.

Shopware Analytics

To utilize the Shopware Analytics extension, it is necessary to share your data. By providing us with your
data, you assist us in enhancing our platform and developing new features and services. This enables us to
actively improve our services using advanced technologies such as machine learning and specialised
pattern recognition. The analysis of this data propels the continuous development of our product and
promotes data-driven services for business success.

The Shopware Analytics extension expands the analysis options of your shop. Once you have installed
the extension, you will find the new analyses in the Dashboard > Statistics menu.

https://docs.shopware.com/en/shopware-6-en/content/ShoppingExperiences


To use this service, it is necessary that you to grant Shopware access to your data so that we can analyse
orders, customers, payments, etc. 

The data is currently being calculated on your system. Therefore, be aware that large amounts of data can
have an impact on system performance.

 

In the top right-hand corner, you can select the time period (1) you would like to analyse.



There are fixed selection options such as yesterday, the last 6 months, the current year or you can specify
a time period that you would like to view.

You can also specify further filter conditions under Filter (2).

You can restrict the selection of data for the statistics to specific sales channels, countries or customer
groups.

Total sales

This statistic shows you the total value of your orders for the evaluation period. 



The report uses gross sales with status paid but without any fees or deductions . 

Hover the mouse pointer over the info button to obtain additional information on this report. 

Via the context menu ... this action is available to you:

Export as CSV - Download the evaluation data as a comma-separated file (CSV), which you can use
in a spreadsheet, for example.

Orders

In this analysis you can see the development of the number of orders. For example, you can see when the
most orders are placed in your shop. The Y-axis shows you the number of orders, the X-axis gives you
information about the time frame.

Hover the mouse pointer over the info button to obtain additional information on this report.

Via the context menu ... this action is available to you:

Export as CSV - Download the evaluation data as a comma-separated file (CSV), which you can use
in a spreadsheet, for example.

Average order value

The analysis periodically determines the average order value of all orders received during this period. The
Y-axis shows you the average order value in your currency, while the X-axis gives you information for the
time frame.



Displays the quotient of gross sales divided by the total count of orders. Discounts, fees, and shipping cost
are not taken into account.

Hover the mouse pointer over the info button to obtain additional information on this report.

Via the context menu ... this action is available to you:

Export as CSV - Download the evaluation data as a comma-separated file (CSV), which you can use
in a spreadsheet, for example.

Payment methods

In this report, you can see which payment methods are used in your shop and in what proportion.

Hover the mouse pointer over the info button to obtain additional information on this report. 



Customers

Track the development of the total number of your customers with this report. The Y-axis shows you the
total number of customers, while the X-axis gives you information for the time frame.

Hover the mouse pointer over the info button to obtain additional information on this report.

Via the context menu ... this action is available to you:

Export as CSV - Download the evaluation data as a comma-separated file (CSV), which you can use
in a spreadsheet, for example.

New Customers

Use this analysis to find out which customer growth you had on which day in absolute figures. The Y-axis
displays the total number of new customers, while the X-axis gives you information for the time frame.



Hover the mouse pointer over the info button to obtain additional information on this report. 

Via the context menu ... this action is available to you:

Export as CSV - Download the evaluation data as a comma-separated file (CSV), which you can use
in a spreadsheet, for example.

Discounts and promotions

This evaluation shows you how your promotions and discounts were used by customers and how often they
were activated.

Hover the mouse pointer over the info button to obtain additional information on this report.

Via the context menu ... this action is available to you:

Export as CSV - Download the evaluation data as a comma-separated file (CSV), which you can use
in a spreadsheet, for example

Sales by manufacturer

This analysis shows you exactly how many products were sold per manufacturer.



Hover the mouse pointer over the info button to obtain additional information on this report.

Via the context menu ... this action is available to you:

Export as CSV - Download the evaluation data as a comma-separated file (CSV), which you can use
in a spreadsheet, for example.

Icons in tables

With version 1.1.0, the function has also been added that you can now display the icons/logos of, for
example, the shipping method, the payment method or many more in the tabular evaluations.

Sales by country

In this analysis you can see to which countries you have sold your products. You can switch between the
billing address and the delivery address at the top right.

 Hover the mouse pointer over the info button to obtain additional information on this report.

Via the context menu ... this action is available to you:



Export as CSV - Download the evaluation data as a comma-separated file (CSV), which you can use
in a spreadsheet, for example.

Product sales

With the help of this analysis, you can easily see which products have been sold in your store and how
often. You also have the option of displaying all variant products individually or running them under the
main product. You can change this using the button at the top right.

Hover the mouse pointer over the info button to obtain additional information on this report.

Via the context menu ... this action is available to you:

Export as CSV - Download the evaluation data as a comma-separated file (CSV), which you can use
in a spreadsheet, for example.

Shopware Commercial

Why do I need Shopware Commercial?

The Shopware Commercial extension is required for you to use the functions and features included in your
plan (Shopware Rise, Evolve or Beyond). Once you activate the extension, your booked plan will be
matched and all available features will be unlocked and provided to you. You can find an overview of the
individual functions of the plans here.

Also, future features and innovations will be integrated into your system exclusively via Shopware
Commercial, so you don't have to perform separate updates or changes.

Where can I find the extension?

https://docs.shopware.com/en/shopware-6-en/features
https://docs.shopware.com/en/shopware-6-en/extensions/shopware-commercial#overview-of-features-per-plan


You can find the extension under Extensions > My Extensions. If you use Shopware in the cloud, the
extension is already pre-installed. Pre-installed apps are not displayed under My Extensions, but they are
available to you.
In the self-hosted variant, you have to install the extension yourself before you can use it.

How do I install the extension?

As already mentioned, you don't need to do anything else if you use Shopware in the cloud. In self-hosted
installations you will find the app under Extensions > My Extensions > Shopware Commercial.

There you can install the extension - if you haven't already done so - and activate it (1).

As mentioned above, the extension must be installed manually if you use Shopware in the Self-hosted
variant.

The installation is basically the same as for all other extensions. To do this, go to the Extensions > Store
section in your administration and search for Shopware Commercial and add the extension. You can find
more information about this process in the article Adding an extension.
 

Overview of features per plan

With the Commercial extension, you can activate the features that are available for your plan. The list
below shows all the features that are played without an additional extension. If you would like a complete
list of all features, you can find it here.

Features / Plans Shopware
Rise

Shopware
Evolve 

Shopware
Beyond

AI Copilot

https://docs.shopware.com/en/shopware-6-en/saas/extensions#add-an-extension
https://docs.shopware.com/en/shopware-6-en/features/commercial/feature-comparison


AI Copilot | content for Shopping
Experiences X X X

AI Copilot | customer classification X X X

AI Copilot | export assistant X X X

AI Copilot | image keyword assistant X X X

AI Copilot | review summary X X X

AI Copilot | custom checkout message X X X

AI Copilot | product properties X X X

AI Copilot | translation for reviews X X X

AI Copilot | product description X X X

AI Copilot | Search by context X X X

Workflow & Automation

Rule Builder | preview X X X

Flow Builder | share flows X X X

Flow Builder | webhook actions    X X

Flow Builder | delayed actions     X

https://docs.shopware.com/en/shopware-6-en/features/shopware-rise/ai-copilot#ai-generated-content-for-shopping-experiences
https://docs.shopware.com/en/shopware-6-en/features/shopware-rise/ai-copilot#ai-generated-content-for-shopping-experiences
https://docs.shopware.com/en/shopware-6-en/features/shopware-rise/ai-copilot#ai-based-customer-classification
https://docs.shopware.com/en/shopware-6-en/features/shopware-rise/ai-copilot#ai-export-assistant
https://docs.shopware.com/en/shopware-6-en/features/shopware-rise/ai-copilot#image-keyword-assistant
https://docs.shopware.com/en/shopware-6-en/features/shopware-rise/ai-copilot#ai-generated-summary-of-ratings
https://docs.shopware.com/en/shopware-6-en/features/shopware-rise/ai-copilot#custom-checkout-message
https://docs.shopware.com/en/shopware-6-en/features/shopware-rise/ai-copilot#ai-generated-product-properties
https://docs.shopware.com/en/shopware-6-en/features/shopware-rise/ai-copilot#ai-based-translation-for-reviews
https://docs.shopware.com/en/shopware-6-en/features/shopware-rise/ai-copilot#ai-description-assistant
https://docs.shopware.com/en/shopware-6-en/settings/search#search-by-context
https://docs.shopware.com/en/shopware-6-en/settings/rules#preview-mode
https://docs.shopware.com/en/shopware-6-en/settings/Flow-Builder#share-flows
https://docs.shopware.com/en/shopware-6-en/settings/Flow-Builder#webhook-actions-in-flow-builder
https://docs.shopware.com/en/shopware-6-en/settings/Flow-Builder#delayed-actions


Content Management & Design      

3D Viewer Block in Shopping
Experiences X X X

Inventory & Order management

Returns management X X X

Multi-inventory     X

Subscription     X

B2B capabilities      

Enhanced roles and permissions
management   X X

Quote management   X X

Sales Agent   X X

Approval processes   X X

Quick ordering   X X

Order list   X X

Customer-specific pricing     X

Customer experience & Marketing

https://docs.shopware.com/en/shopware-6-en/content/ShoppingExperiences#blocks
https://docs.shopware.com/en/shopware-6-en/content/ShoppingExperiences#blocks
https://docs.shopware.com/en/shopware-6-en/orders/returns-management
https://docs.shopware.com/en/shopware-6-en/features/multi-inventory
https://docs.shopware.com/en/shopware-6-en/settings/shop/subscriptions
https://docs.shopware.com/en/shopware-6-en/commercial-features/b2b-components#employee-management
https://docs.shopware.com/en/shopware-6-en/commercial-features/b2b-components#employee-management
https://docs.shopware.com/en/shopware-6-en/commercial-features/b2b-components#quote-management
https://docs.shopware.com/en/shopware-6-en/extensions/sales-agent
https://docs.shopware.com/en/shopware-6-en/commercial-features/b2b-components#approve-orders
https://docs.shopware.com/en/shopware-6-en/commercial-features/b2b-components#quick-order-function
https://docs.shopware.com/en/shopware-6-en/commercial-features/b2b-components#shopping-lists
https://docs.shopware.com/en/shopware-6-en/extensions/customer-specific-pricing


Advanced Search 2.0   X X

https://docs.shopware.com/en/shopware-6-en/settings/advanced-search-2-0


CLI commands of the extension
With the installation and activation of the plugin additional CLI commands are available, you can find the
list here.

Shopware Publisher

The Shopware Publisher is available to you as an extension from the Shopware Evolve plan.

Shopware Publisher allows you to create drafts of an existing layout and editing existing shopping
experiences without changing the live version of a layout. An activity feed shows you who has already
worked on the layouts and a preview allows you to view unpublished layouts in the storefront.

Installation

As part of the Shopare Evolve plan, the Shopware Publisher is available to you as an extension.
You can download and install the extension under Extensions > My extensions. 
If you have logged in to the Shopware Account tab with your account, the extension is available to you
under the Apps tab. There you can install Shopware Publisher and then activate it. 

You can find more information about the My Extensions section here.

Drafts

With Shopware Publisher, you have the option of creating multiple versions of one and the same shopping
experience without changing the current live version of the shopping experience.

Create a new draft layout

The Save button has been extended with a new button with an arrow, which makes it possible to save the
current layout as a draft, so that the saved contents are not directly live.

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/shopware-cli#commercial
https://docs.shopware.com/en/shopware-6-en/extensions/myextensions


Click on save to save the current layout in the live version. To create a new version of an already existing
layout, first make changes to the current layout as usual without simply saving them by clicking on save.
Instead, click on the button with the arrow next to the Save button and select save as new draft.

Then give the draft a meaningful name and save it using the save draft button.

Edit and save the draft.

When editing a draft, some buttons work differently compared to when you are working on the live layout.

Draft Badge (1): you will recognise that you are in a draft by the draft badge in the upper left corner.
User abbreviation (2): The user abbreviation at the top right tells you which user has last worked on this
design.
Preview (3): This button opens a new tab showing the current draft as a preview in the frontend. This
gives you the ability to view the draft in the frontend without having to switch it live.
Save (4): Unlike when you are working on the live layout, you save the design here using the save button.



Doing so does not switch the layout to live.
Save and publish (5): Click on the arrow to the right of the Save button to select save and publish. This
overwrites the current live layout and saves this design.

Drafts in the overview

In the overview, the additional draft is displayed within the tile of the layout.

Live layout (1): In the overview, if you click on the middle rectangle in the tile, you will go to the editor for
the layout that is currently being used live.
Draft (2):In the upper left corner of each layout tile there is a badge indicating how many drafts there are
next to the live layout. Click on the badge to open one of the drafts instead of the Live Layout.
Changes (3): The bottom right corner shows how many other users made changes to this layout.

Activity

On the right-hand side, above the layout assignment, you will find the menu item Activity (1), that shows
you which user has made which changes to the current layout or to the draft.



Every change to the layout is listed here. It is indicated when and by whom (2) the change was made
and what exactly was changed. The changes are displayed regardless of whether you are in the live layout
or in a draft.
If you click on the drop-down menu show changes (3) under each adjustment and move the mouse over
a change (4), it will be highlighted in the layout. This gives you a quick overview of which changes have
been made most recently. 

Social Shopping - Instagram, Pinterest &
Facebook

Installation

Social Shopping is an extension that is part of the Shopware Rise plan.

If at least the Shopware Rise plan is stored for the store domain in the Shopware account, you can
download and install it under Extensions > My Extensions.
The prerequisite is that you are logged in with your account in the Shopware Account tab. 
After the extension has been installed, you can activate it via the button on the left side.

General Information

The extension provides additional sales channels that allow easy integration into the well-known social
media services. In most cases this is done through an export feed, which is integrated into the respective



platform
 

If you want to disable Social Shopping, it is necessary to delete the sales channels created with Social
Shopping beforehand.

In the customer and order areas of the administration, the column "Referral" is added to the entries for
customers and orders. This tells you where the customers or orders come from if they were placed via a
social shopping sales channel. For this, however, the referral code must be included in the individual
templates. Information on this can be found in the various template areas.

Facebook

The "Facebook" sales channel provides the data required for export to Facebook in an XML feed.
 

Configuration

Language selection (1): Here you define for which language you want to setup the configuration. It is not
necessary to maintain the settings in each language, because these settings are always inherited from the
main language, if no own settings are made in a language. However, it may be useful to select the
respective storefront sales channel domain for each language, for example, to direct customers to the
appropriate language.

In the tab General (2) you can configure the export feed generated later. The tabs Statistics (3), 
Unpublished Products (4), Intergration (5) and Template (6) will only be displayed after the basic
configuration has been completed and the settings have been saved.



 

General

Name (7): Enter a name for the sales channel here. This is used, for example, in the sales channel
overview in the menu on the left side.
Active (8): Activate the generation of the feed. If the feed is not active, no further generation takes
place and it cannot be accessed through the URL.
Storefront sales channel (9): Select here which storefront should be used for the integration. This
storefront will be used to display or purchase the articles through Facebook.
Storefront sales channel domain (10): Based on the selected storefront sales channel you can
choose the domain to be used. This is especially important if the storefront is accessible through
different domains or if different languages are used.
Currency (11): Here you define the currency in which the products should be displayed. You can
choose from the currencies that are available in the assigned storefront sales channel.
Dynamic product group (12): By assigning a dynamic product group, you define which products
should be exported to the feed for Facebook. To learn how to create a dynamic product group, please
refer to the appropriate documentation.

Additional settings

https://docs.shopware.com/en/shopware-6-de/Catalogues/Dynamicproductgroups


Import variants as own products (1): With this setting you can determine whether each variant of
variant products is transferred to Facebook as an independent product. Alternatively, a collective
product is used, in which the general product information is listed. However, information on the
individual variants is not included.
Generation interval (2): Use this setting to define how often the feed should be regenerated for
export. If you select "Live", the feed is generated each time it is called up. For production systems,
we recommend that you do this using the scheduler. More information about the scheduler you can
find here.
Generate by Scheduler (3): This option allows you to have the feed generated via the Message
Queue System with a scheduled task. Please note that the feed will only be generated when the
generation interval has expired. To learn how to set up Scheduled Tasks, see the Scheduled Tasks
article.
Default Google Product Category ID (4): The Google Product Category ID determines the
category in which the products will be included on Facebook. Please note that only purely numeric
values can be used here. You can find more information on this on the Google help page, which is
also linked in the admin section at the appropriate place. 
Time of last generation (5): Here you can see when the export feed was last generated. This also
allows you to see if the generation by the scheduler is executed correctly.

Options

Please note that the item options only becomes available after the sales channel has been created (saved
initially).

 
Delete sales channel (1): Here you can delete the sales channel within Shopware. It may be
necessary to make additional adjustments to Facebook.

Statistics

With the statistics, you can view various key figures of your orders via Facebook. These are divided into
orders, customers and turnover. Each statistic can be limited to different time periods, such as the last 24
hours or the last 30 days, via an option in the upper right corner.

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/message-queue-and-scheduled-tasks#scheduled-tasks
https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/message-queue-and-scheduled-tasks
http://support.google.com/merchants/answer/6324436


Without the respective variable for the referral code in the template, the statistics cannot be calculated.
You can find more information on this in the template section.

Unpublished products

Please note that the unpublished products tab is only available after you have set up and saved the
general configuration.

 
Validate products (1): You can validate products at this point.
Result of the validation (2): After the validation has been carried out, you can see here whether
the products are transferd complete. If the validation should determine that products are not valid,
the corresponding products are listed here. In this case you should then check whether any data is
missing or whether the existing data is invalid (e.g. due to characters that cannot be displayed
correctly).

 
Integration

https://docs.shopware.com/en/shopware-6-en/extensions/social-shopping#template


Shopware itself provides you with the data required for integration into Facebook in an export feed. The
integration with Facebook is done directly in your Facebook settings.

Please note that the Integration tab is only available after you have set up and saved the general
configuration.

Export-URL (1): The generated feed can be accessed under the export URL and can be queried from
Facebook.

You can find more information in the Facebook documentation.
General information about the shop on Facebook
https://de-de.facebook.com/business/help/238403573454149?id=206236483305742
Information on catalog management
https://www.facebook.com/business/help/125074381480892?id=725943027795860
and
https://www.facebook.com/business/learn/lessons/manage-inventory-with-catalogs

Template

https://de-de.facebook.com/business/help/238403573454149?id=206236483305742
https://www.facebook.com/business/help/125074381480892?id=725943027795860
https://www.facebook.com/business/learn/lessons/manage-inventory-with-catalogs


 
The template determines the structure of the product export file. The template is divided into a header line,
a product line and a footer line.
If you use a template in the General tab, usually no adjustments are necessary here. The correct document
templates for the respective comparison portals are already included in the templates. 
The Test template (1) button checks whether there are any syntax errors in the template. With
Generate preview (2) you can directly view the content of the created export file.

More information about the templates you can find here.

Under Variables (3) you can see which data you can use for the template.

With a click on the arrow, you can see a dropdown with all available variables. There you can copy the
variable you want to the clipboard by clicking on the copy symbol again.

Referral-Code

In order for the statistics to be calculated, the Facebook sales channel template must contain the following
variable:

{{ socialShoppingSalesChannel.salesChannelId }}

This variable is automatically added to the standard template for new social shopping installations or
updates. However, if you have previously adapted the template yourself, you must manually add this
variable once and thereby extend the variable to the SEO URL, so that the following line is then created:

https://docs.shopware.com/en/shopware-6-en/Productcomparison#template


<g:link>{{ seoUrl('frontend.detail.page', {'productId': product.id}) }}?referralCode={{ socialShoppingSalesChannel.salesChannelId }}</g:link>

Instagram

The Instagram sales channel provides an XML feed that contains all information relevant to Instagram.

Configuration

Language selection (1): Here you select for which language you want to hear the configuration. It is not
necessary to maintain the settings in each language, because these settings are always inherited from the
main language, if no own settings are made in a language. However, it may be useful to select the
respective storefront sales channel domain for each language, for example, to direct customers to the
appropriate language.

In the tab General (2) you configure the export feed generated later. The tabs Statistics (3), 
Unpublished products (4), Integration (5) and Template (6) will only be displayed after the basic
configuration has been made and the settings have been saved.

General

Name (7): Enter a name for the sales channel here. This is used, for example, in the sales channel
overview in the menu on the left side.
Active (8): Activate the generation of the feed. If the feed is not active, no further generation takes
place and it cannot be accessed through the URL.
Storefront sales channel (9): Select here which storefront should be used for the integration. This
storefront will be used to display or purchase the articles throughInstagram
Storefront sales channel domain (10): Based on the selected storefront sales channel you can
choose the domain to be used. This is especially important if the storefront is accessible through



different domains or if different languages are used.
Currency (11): Here you define the currency in which the products should be displayed. You can
choose from the currencies that are available in the assigned storefront sales channel.
Dynamic product group (12): By assigning a dynamic product group, you define which products
should be exported to the feed for Instagram. To learn how to create a dynamic product group,
please refer to the appropriate documentation.

Additional settings

 

 
Import variants as own products (1): With this setting you can determine whether each variant of
variant products is transferred to Instagram as an independent product. Alternatively, a collective
product is used, in which the general product information is listed. However, information on the
individual variants is not included.
Generation interval (2): Use this setting to define how often the feed should be regenerated for
export. If you select "Live", the feed is generated each time it is called up. For production systems,
we recommend that you do this using the scheduler. More information about the scheduler you can
find here.
Generate by Scheduler (3): This option allows you to generate the feed by cronjob at a certain
time. Please note that the feed is only generated when the generation interval has expired.
Default Google Product Category ID (4): The Google Product Category ID determines the
category in which the products will be included on Instagram. Please note that only purely numeric
values can be used here. You can find more information on this on the Google help page, which is
also linked in the admin section at the appropriate place. 
Time of last generation (5): Here you can see when the export feed was last generated. This also
allows you to see if the generation by the scheduler is executed correctly.

Options

Please note that the item options only becomes available after the sales channel has been created (saved
initially).

 

https://docs.shopware.com/en/shopware-6-de/Catalogues/Dynamicproductgroups
https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/message-queue-and-scheduled-tasks#scheduled-tasks
http://support.google.com/merchants/answer/6324436


Delete sales channel (1): Here you can delete the sales channel within Shopware. It may be
necessary to make additional adjustments to Facebook.

Statistics

With the statistics, you can view various key figures of your orders via Instagram. These are divided into
orders, customers and turnover. Each statistic can be limited to different time periods, such as the last 24
hours or the last 30 days, via an option in the upper right corner.

Without the respective variable for the referral code in the template, the statistics cannot be calculated.
You can find more information on this in the template section.

Unpublished products

Please note that the unpublished products tab is only available after you have set up and saved the
general configuration.

 
Validate products (1): You can validate products at this point.

https://docs.shopware.com/en/shopware-6-en/extensions/social-shopping#template-1


Result of the validation (2): After the validation has been carried out, you can see here whether
the products are transferd complete. If the validation should determine that products are not valid,
the corresponding products are listed here. In this case you should then check whether any data is
missing or whether the existing data is invalid (e.g. due to characters that cannot be displayed
correctly).

  
Integration 

In order to integrate the products exported through the feed with Instagram, it is necessary, among other
things, to link the Instagram profile to your own Facebook account.
 

Please note that the integration tab is only available after you have set up and saved the general
configuration.

Export-URL (1): Under the export URL, the generated feed is accessible and can be queried by
Instagram.

For details on this and how to integrate the data, please refer to the documentation on the Instagram 
https://business.instagram.com/tag-in

Template

https://www.facebook.com/business/instagram/shopping/guide


 
The template determines the structure of the product export file. The template is divided into a header line,
a product line and a footer line.
If you use a template in the General tab, usually no adjustments are necessary here. The correct document
templates for the respective comparison portals are already included in the templates. 
The Test template (1) button checks whether there are any syntax errors in the template. With
Generate preview (2) you can directly view the content of the created export file.

More information about the templates you can find here.

Under Variables (3) you can see which data you can use for the template.

https://docs.shopware.com/en/shopware-6-en/Productcomparison#template


With a click on the arrow, you can see a dropdown with all available variables. There you can copy the
variable you want to the clipboard by clicking on the copy symbol again.

Referral-Code

In order for the statistics to be calculated, the Instagram sales channel template must contain the following
variable:

{{ socialShoppingSalesChannel.salesChannelId }}

This variable is automatically added to the standard template for new social shopping installations or
updates. However, if you have previously adapted the template yourself, you must manually add this
variable once and thereby extend the variable to the SEO URL, so that the following line is then created:

<g:link>{{ seoUrl('frontend.detail.page', {'productId': product.id}) }}?referralCode={{ socialShoppingSalesChannel.salesChannelId }}</g:link>

Google Shopping

In order for the domain of the Google Shopping sales channel to be verified, an HTML tag must be stored.
This file must be located in the public directory of the Shopware installation and be accessible on the web.
Instructions on how to create the HTML tag file and everything else can be found in the Google Merchant
Center.

The "Google Shopping" sales channel provides all information relevant to Google Shopping in an XML feed.

Configuration

Language selection (1): Here you select for which language you want to hear the configuration. It is not
necessary to maintain the settings in each language, because these settings are always inherited from the
main language, if no own settings are made in a language. However, it may be useful to select the
respective storefront sales channel domain for each language, for example, to direct customers to the
appropriate language.

In the tab General (2) you configure the export feed generated later. The tabs Statistics
(3), Unpublished products (4), Integration (5) and Template (6) will only be displayed after the basic
configuration has been made and the settings have been saved.

https://support.google.com/merchants/answer/176793?hl=en
https://support.google.com/merchants/answer/176793?hl=en


General

Name (7): Enter a name for the sales channel here. This is used, for example, in the sales channel
overview in the menu on the left side.
Active (8): Activate the generation of the feed. If the feed is not active, no further generation takes
place and it cannot be accessed through the URL.
Storefront sales channel (9): Select here which storefront should be used for the integration. This
storefront will be used to display or purchase the articles through Google Shopping.
Storefront sales channel domain (10): Based on the selected storefront sales channel you can
choose the domain to be used. This is especially important if the storefront is accessible through
different domains or if different languages are used.
Currency (11): Here you define the currency in which the products should be displayed. You can
choose from the currencies that are available in the assigned storefront sales channel.
Dynamic product group (12): By assigning a dynamic product group, you define which products
should be exported to the feed for Google Shopping. To learn how to create a dynamic product group,
please refer to the appropriate documentation.

Additional settings

https://docs.shopware.com/en/shopware-6-de/Catalogues/Dynamicproductgroups


Import variants as own products (1): With this setting you can determine whether each variant of
variant products is transferred toGoogle Shopping as an independent product. Alternatively, a
collective product is used, in which the general product information is listed. However, information on
the individual variants is not included.
Generation interval (2): Use this setting to define how often the feed should be regenerated for
export. If you select "Live", the feed is generated each time it is called up. For production systems,
we recommend that you do this using the scheduler. More information about the scheduler you can
find here.
Generate by Scheduler (3): This option allows you to generate the feed by cronjob at a certain
time. Please note that the feed is only generated when the generation interval has expired.
Default Google Product Category ID (4): The Google Product Category ID determines the
category in which the products will be included on Google Shopping. Please note that only purely
numeric values can be used here. You can find more information on this on the Google help page,
which is also linked in the admin section at the appropriate place. 
Time of last generation (5): Here you can see when the export feed was last generated. This also
allows you to see if the generation by the scheduler is executed correctly.

Options

Please note that the item options only becomes available after the sales channel has been created (saved
initially).

Delete sales channel (1): Here you can delete the sales channel within Shopware. It may be
necessary to make additional adjustments to Google Shopping.

Statistics

With the statistics, you can view various key figures of your orders via Google Shopping. These are divided
into orders, customers and turnover. Each statistic can be limited to different time periods, such as the last
24 hours or the last 30 days, via an option in the upper right corner.

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/message-queue-and-scheduled-tasks#scheduled-tasks
http://support.google.com/merchants/answer/6324436


Without the respective variable for the referral code in the template, the statistics cannot be calculated.
You can find more information on this in the template section.

Unpublished products

Please note that the unpublished products tab is only available after you have set up and saved the
general configuration.

 

Validate products (1): You can validate products at this point.
Result of the validation (2): After the validation has been carried out, you can see here whether
the products are transferd complete. If the validation should determine that products are not valid,
the corresponding products are listed here. In this case you should then check whether any data is
missing or whether the existing data is invalid (e.g. due to characters that cannot be displayed
correctly).

 
Integration

https://docs.shopware.com/en/shopware-6-en/extensions/social-shopping#template-2


In the tab Integration you will find further information on how to integrate the feed into Google.

Please note that the integration tab is only available after you have set up and saved the general
configuration.

Export-URL (1): Under the export URL, the generated feed is accessible and can be queried by
Google Shopping.

How you can add items to Google Shopping is explained in detail in the Google documentation
https://support.google.com/merchants/topic/7294771?hl=de&ref_topic=7259125

Template

The template determines the structure of the product export file. The template is divided into a header line,
a product line and a footer line.
If you use a template in the General tab, usually no adjustments are necessary here. The correct document
templates for the respective comparison portals are already included in the templates. 

https://support.google.com/merchants/topic/7294771?hl=de&ref_topic=7259125


The Test template (1) button checks whether there are any syntax errors in the template. With
Generate preview (2) you can directly view the content of the created export file.

More information about the templates you can find here.

Under Variables (3) you can see which data you can use for the template.

With a click on the arrow, you can see a dropdown with all available variables. There you can copy the
variable you want to the clipboard by clicking on the copy symbol again.

Referral-Code

In order for the statistics to be calculated, the Google Shopping sales channel template must contain the
following variable:

{{ socialShoppingSalesChannel.salesChannelId }}

This variable is automatically added to the standard template for new social shopping installations or
updates. However, if you have previously adapted the template yourself, you must manually add this
variable once and thereby extend the variable to the SEO URL, so that the following line is then created:

<link>{{ seoUrl('frontend.detail.page', {'productId': product.id}) }}?referralCode={{ socialShoppingSalesChannel.salesChannelId }}</link>

Pinterest

https://docs.shopware.com/en/shopware-6-en/Productcomparison#template


Pinterest is not integrated through export feeds. Meta data is used here, through which Pinterest can
retrieve the required information.

Configuration

Language selection (1): Here you define for which language you want to setup the configuration. It is not
necessary to maintain the settings in each language, because these settings are always inherited from the
main language, if no own settings are made in a language. However, it may be useful to select the
respective storefront sales channel domain for each language, for example, to direct customers to the
appropriate language.

In the tab General (2) you can configure the export feed generated later. The tabs Statistics (3) and 
Intergration (4) will only be displayed after the basic configuration has been completed and the settings
have been saved.

General

Name (5): Enter a name for the sales channel here. This is used, for example, in the sales channel
overview in the menu on the left side.
Active (6): Activate the generation of the feed. If the feed is not active, no further generation takes
place and it cannot be accessed through the URL.
Storefront sales channel (7): Select here which storefront should be used for the integration. This
storefront will be used to display or purchase the articles through Facebook.
Storefront sales channel domain (8): Based on the selected storefront sales channel you can
choose the domain to be used. This is especially important if the storefront is accessible through
different domains or if different languages are used.
Currency (9): Here you define the currency in which the products should be displayed. You can
choose from the currencies that are available in the assigned storefront sales channel.



*Options
Please note that the item options only becomes available after the sales channel has been created (saved
initially).

Delete sales channel (6): Here you can delete the sales channel within Shopware. It may be
necessary to make additional adjustments to Pinterest.

Integration

In the tab Integration you will find some basic information on how the integration in Pinterest works. There
is also a button for validation. This button calls up the Rich Pins Validator page at Pinterest. To view the
page, you may need to log in to Pinterest. This validator then checks whether all data relevant to Pinterest
can be called up. You can find more information about the Rich Pins in the documentation of Pinterest.

Please note that the integration tab is only available after you have set up and saved the general
configuration.

Customise default templates

The templates of the Social Shopping sales channels use a standard template. However, it could happen
that your products require further details or you simply want to add information. The template language
TWIG allows you to customise the template according to your wishes. Code snippets for frequently
requested additions can be found here.

Language Pack
This extension allows you to offer your shop in additional languages. The following languages are included
for use in Administration and Storefront:

https://developers.pinterest.com/docs/rich-pins/overview/
https://docs.shopware.com/en/shopware-6-en/tutorials-und-faq/howto/product-comparison-code-snippets


Bosnian
Bulgarian
Croatian
Czech
Danish
Dutch
Finnish
French
Greek
Hindi
Hungarian
Indonesian
Italian
Korean
Latvian
Norwegian
Polish
Portuguese
Romanian
Russian
Serbian(Latin)
Slovak
Slovenian
Swedish
Spanish
Turkish
Ukrainian
Vietnamese

Installation

The installation of the Shopware Language Pack is possible in several ways.
On the one hand, you can obtain and configure the extension directly during the installation of Shopware in
the initial setup wizard.
On the other hand, you can also license the Shopware Language Pack extension free of charge directly in
the Shopware Store at store.shopware.com. You can then download and install the extension under 
Extensions > My Extensions. 

http://store.shopware.com/


It is important that you have previously logged in with your account in the Shopware Account tab. 
After the extension has been installed, you can activate it using the button to the left of the extension.

Switching from the old single language extensions

The language package replaces the previous individual language extensions, which will no longer be
developed further from Shopware 6.4.0.0.
In order to install the new complete language package, it is required to uninstall all individual language
packages first. This is done under Extensions > My Extensions > Apps using the "..." menu next to the
respective extension.
During the uninstallation process, you can select whether the previous data should be retained. This can be
particularly useful if you have already made adjustments to text modules.

Settings
Languages for administration

After installing and activating the extension, the languages it contains are directly active for use in the
administration.
The administration user can then select the language in his profile settings.
If a language is not to be displayed for selection in the profile settings, deactivate the language using the
button on the right-hand side.

Languages for the store front

https://docs.shopware.com/en/shopware-6-en/einstellungen/Profilesettings


In the sales channels section, you can choose which languages can be used for the storefront.
These languages are not automatically activated when the extension is installed.
To be able to use a language, first activate it using the button on the right-hand side.
You can then select the language in the sales channel settings.

Miscellaneous

The available languages are maintained on the Crowdin platform.
As soon as a language is fully maintained there, it is made available for use in Shopware through an update
of the extension.

Zettle by PayPal
Zettle by PayPal is a service that allows you to accept card payments wherever you are using a
smartphone and tablet chip card reader and your own app.

The Zettle integration, which is part of the PayPal extension, gives you the opportunity to offer your
products via the Zettle interface as an additional sales channel, which means you can offer your products
locally, for example in a shop. 
For more information about the service click here. 

Installation

Zettle is not a extension in itself but is part of PayPal and therefore does not need to be installed
separately. You can find out how to install the PayPal extension here.

Setup

To synchronise your products with Zettle, you need a new sales channel. If you create a new channel, you
can now also use the Zettle sales channel. Once you have created it, the setup wizard will guide you step-
by-step through the setup of the Zettle interface.

Account Setup

The first step is to establish a connection to an existing Zettle account. If you don't have a Zettle account
yet, you can create one in this step or directly here.

https://docs.shopware.com/en/shopware-6-en/settings/saleschannel#general-settings
https://crowdin.com/project/shopware6
https://www.zettle.com/gb
http://docs.shopware.com/de/shopware-6-en/plugins/paypal?category=shopware-6-en/plugins
https://www.zettle.com/gb/integrations/e-commerce/shopware?utm_source=partnership&utm_medium=ecommerce&utm_campaign=shopware&utm_term=cloud


Create Zettle-Account (1): If you don't have a Zettle account, you can go directly to the Zettle
registration page here to create a new account.

API key (2): If you already have a Zettle account you can link it to Shopware here. This requires an API
key from the Zettle administration. In your Zettle account you can create API keys on the left hand side via
Integrations>Create API Keys. 
The Generate API Key link (3) will take you directly to this configuration.

Here you first specify a key name, how the API key should be listed in the Zettle configuration. You can
also see what rights the interface will be given.



Once you have created the key, it will be displayed and you can copy it. Then go back to the Shopware tab
and paste the key into the API Key field.

Connection

After you have connected Shopware to your Zettle account in the first step, the account you are using will
be shown here again for confirmation. If you have more than one Zettle account and have chosen the
wrong one, you can disconnect in this window to return to the first step.
If the account is the right one, simply click Next.

Customisation

 

In the customisation, you first define a name (1) for the sales channel in your Shopware environment.
Then you enter your shop domain (2). This will be used by Zettle to download media data for the



synchronised products. 

Product selection

In the step product selection you enter the sales channel from which you want to transfer the products to
the Zettel sales channel.

Product synchronisation

In the Product Synchronization step, you specify what to do with the products that were previously in the
Zettle product library.

With the Replace Zettle Library option (1) you will ensure that all products currently in your Zettle
account are removed. Only the products from Shopware will then be added.
If you select Add Shopware products (2), the products previously stored in Zettle will remain. The
products from Shopware will be added to these products. 



The number of variant groups must be between 1 and 3 (e.g. size, color, page). If there are more groups,
the synchronization of the product will be cancelled

The maximum number of characters in the description is 1024

Price-synchronisation

Here you specify how you want to synchronise the prices of your products with Zettle.

On the one hand, you have the option to synchronise prices with VAT (1). With this option, the gross
prices are transferred to Zettle including VAT. 

On the other hand, you can choose don't synchronise prices (2). With this option, prices are not
transferred to Zettle. After synchronisation, you can adjust the prices in the Zettle product library. 

Configuration

Once you've successfully set up the Zettle interface, you can open it at any time and configure it later. To
do this, open the Zettle sales channel you created in the Sales Channels section.

Account

The Account section gives you access to all information from your Zettle account at all times.



You can access your Zettle account at any time via the account link (1) to manage it. On the right hand
side (2) you will find the current status and when the products were last synchronised.  
You can always use the Edit connection button (3) to restart the setup wizard and connect to a new
Zettle account. 

Overview

In the tab Overview you will find all information about the synchronisation of the products.

In the synchronisation section (1) you can see the information about the last synchronisation. You can
see if the last synchronisation was successful, when the last synchronisation was made and when a
complete synchronisation was made. By clicking on the Synchronise Now (2 & 3) buttons you can
directly perform a complete synchronisation. 

Next to the Synchronize Now button you can use the arrow (4) to synchronize only the stock, the product
images or the product details. 

Synchronised Products

This tab gives you an overview of which products are currently synchronised via the Zettle interface.

Next to each product in the list you will be clearly shown whether (1) and at what time (2) it was
updated. 
Via the context menu (3) next to each product you can go directly to the product configuration to make



adjustments to the respective product.

Settings

All the settings you made when setting up the Zettle interface can be changed later in this tab.
General Settings

Name (1): This is the name of the Zettle sales channel in the Shopware Administration.

Active (2): This button enables and disables the Zettle sales channel. When the sales channel is disabled,
there will be no more synchronisation between the Zettle account and Shopware. 
Your Shop Domain (3): The domain from your shop is required by Zettle to download media data for the
synchronised products. 

Synchronisation

With the Replace Zettle Library option (1) you will ensure that all products currently in your Zettle
account are removed. Only the products from Shopware will then be added.
If you select Add Shopware products (2), the products previously stored in Zettle will remain. The
products from Shopware will be added to these products. 

Prices



With the option Synchronise prices with VAT (1) the gross prices are transferred to Zettle including
VAT. 

The Don´t synchronise prices option (2) will not transfer prices to Zettle. After synchronisation, you can
adjust the prices in the Zettle product library.

Credentials

API-Key(1): An API-Key is required to give Shopware access with sufficient rights. You have already
entered this key during the setup. At this point you can change it later. 
Generate API Key (2): This button takes you to your Zettle account to generate the required API key with
the necessary rights. 

Options

Reset synchronisation (1): With this option you reset the synchronisation. All synchronised products will
be marked as unsynchronised. This means that all products will be completely re-synchronised at the next
synchronisation. Note that the next synchronisation may take much longer than usual depending on the
amount of products. 
Delete sales channel (2): If you delete the sales channel, it will be irrevocably removed. The sales
channel will then no longer be available in the Shopware Administration and cannot be restored. However,
all existing orders will remain. Even played catalogues will not be changed by this action. The connection to
Shopware will be removed and no further synchronisation will take place afterwards. 

Logs



In the log you can see all past synchronisations with the status (1) and date (2). If the status was not
successful, you can use the context menu (3) to read the exact error message why the synchronisation
was not successful. 
With the button Clean up log (4) you can delete the list completely. 

Sales Agent
With version 6.5.0.0 the Sales Agent feature is available.

You can define users, that will be able to add or monitor orders for B2B customers.

To use this feature, a separate installation and additional users are necassary. The installation has to be set
up by your agency or adminstrator on a separate server.

The sales agents therefore have their own area, which can be used independently of your store installation.

This can be used via a browser or via mobile devices such as smartphones or tablets.

The corresponding address (URL) is defined on the corresponding server during installation.

The access data for future users is set up via API access.

You can find the corresponding documentation here.

https://developer.shopware.com/docs/products/sales-agent/


The sales agent uses his login credentials (email / password) to login.

Sales Agent Board

If the agent is logged in, the board is presented.

On the left side, you`ll find the menu. With the menu button (1) the menu can be minimized and opened.

The Shopware (2) button opens the account data ot the current user.

With the customer (3) button the list of linked customers will be opened.

Customers

In the list of customers you´ll find several infomrations:

#: shows the position in the list.
COMPANY: Shows the name of the company.
NAME: Shows the name of the contact/debtor.
TOTAL TURNOVER: Shows the current turnover combined of all orders.
EMAIL: Shows the email Address of the contact/debtor
LAST ORDER DATE: Shows the date of the last order.
LOCATION: Shows the address of the customer.
CUSTOMER GROUP: Lists the current customer group of the customer.
SALES CHANNEL: Shows the linked sales channel of the customer.



In the Search (1) field you can add a search term to filter the customers.

There are several links available:

The company name (2)
The Name (3)
The Context Menu (4)

All link to the details page or the customer.

If you click on the Settings (5) Button the following popup appears.

Here you can change the appearance of the customer view.



You can hide or unhide columns
You can deactivate the numbered column
you can activate the striped rows, so the rows will be marked in even and uneven lines.
You can activate the outlines so the columns are better shown
you can activate the frame outlines so the columns are highlighted with a mouse over effect. 

Customer Details

In the customer details you´ll find a complete overview of the customer. It is devided in the General Data
and the Addresses.

Also you can create new orders for the customer.

General

In the General (1) tab the current status of the customer is shown.

(2) the company name and customer number. Also a message if there are alerts, such as unpaid bills.

(3) the general data:

The last order date
The total turnover amount
The order amount



The linked customer group
The linked sales channel, if configured in the settings

Also a Notes (4) field to add additional notes to the customer.

Below you will find the list of orders (5) that exist for the customer.

In the table you will find
Order number
Total value of the order
Order status
Date of the order

Below the orders you´ll find a pager (7) to navigate thru the list of orders.

At the top of the screen, you can add a new order (6) for the customer using a button.

https://docs.shopware.com/en/shopware-en/settings/login-registration#customer-assignment

